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Introduction

Paragon Partition Manager™ 11 Personal is an integrated set of powerful tools that is specially designed to tackle most
of the problems you might face while using PC. A highly intelligent program engine together with built-in advanced
recovery facilities make it possible to securely carry out partitioning operations of any complexity, optimize
performance of NTFS and FAT file systems, migrate the system to another hard disk, etc. without fear to lose precious

data.

In this manual you will find the answers to many of the technical questions, which might arise while using the program.

A

Our company is constantly releasing new versions and updates to its software, that's why
images shown in this manual may be different from what you see on your screen.

What's New in Partition Manager 11

Automatic partition alignment during partitioning/copy operations to optimize performance of your hard disk.

Check FS Integrity and Data Loss Policies to let you specify the acceptable balance between the operation
performance and the risk of data loss.

Better support for 64-bit platforms to reboot your computer to one of the three special modes (Windows
native, Linux, or DOS) to automatically complete operations, which cannot be accomplished under 64-bit
Windows.

AFD (Advanced Format Drive) ready.
Support of 2TB+ and non-512B sector size drives.

USB 3.0 ready.

Product Components

In order to cope with different tasks, the product contains several components:

Windows based set of utilities is the crucial part of the product. With the help of an easy to use launcher you
may find and run tasks of any complexity in the field of data and system protection, hard disk partitioning and
cloning, etc.

Linux/DOS based recovery environment is a multi-platform bootable media that enables to run utilities under

Linux or PTS DOS, and that way to get access to your hard disk for maintenance or recovery purposes. Both
platforms have their strong sides, for instance Linux can boast support of FireWire (i.e. IEEE1394) or USB
devices. It enables to burn CD/DVD discs. However there can be some difficulties with detecting new hardware.
DOS in its turn has no problems of that kind but is limited in features. The Linux/DOS recovery environment
requires no installation and can be of great help when the system fails to boot. Besides it offers a Windows XP
like environment.

Features Overview

This chapter dwells upon key benefits and technical highlights of the product.

Copyright© 1994-2011 Paragon Software Group. All rights reserved.



Features

Let us list some of the features:

User Friendly Fault Minimizing Interface
e Graphical representation of the data to gain a better understanding.

e A handy Launcher to easily find and run the required tasks.

e Comprehensive wizards to simplify even the most complex operations.
e A context sensitive hint system for all functions of the program.

e Previewing the resulting layout of hard disks before actually executing operations (so-called virtual
operations).

Backup Facilities

e Available location for backup images:

- Backup to local mounted partitions.

- Backup to an external mounted storage to provide for a higher level of data protection and system
independence.

- Backup to a network drive to stand a better chance of success in case of a hard disk failure.

Restore Facilities

e Restore an entire disk, separate partitions or only files you need from the previously created backup image.

A This feature is only available for the bootable recovery environment.

Copy Facilities

e Partition/hard disk copy to successfully transfer all on-disk information including standard bootstrap code and

other system service structures, thus maintaining the operating system’s working capability.

A Copy functionality can also be used as an alternative way of data protection.

Boot Management Facilities

e Boot Manager Setup Wizard to easily manage several operating systems on one computer.

Partition/Hard Disk Management Facilities

e Basic functions for initializing, partitioning and formatting hard disks (create, format, delete). Instead of the
standard Windows disk tools, the program supports all popular file systems.

o Express Create Partition Wizard to create a new partition in the most appropriate place of a hard disk, format it

to NTFS and then make it available in the system by assigning a drive letter.

Copyright© 1994-2011 Paragon Software Group. All rights reserved.
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Merge Partitions Wizard to consolidate the disk space, which originally belongs to two adjacent partitions
(NTFS, FAT16/FAT32), into a single, larger partition.

Redistribute Free Space Wizard to increase free space on one partition by up-taking the on-disk unallocated

space and the unused space of other partitions.

Express Resize Partitions Wizard to increase free space on one partition by up-taking the unused space of an

adjacent partition of a hard disk (including partitions of Apple Boot Camp).

NTFS hot resize upward to enlarge an NTFS partition (system, locked) without rebooting Windows and
interrupting its work.

Convert a file system (FAT16/32, NTFS, Ext2/Ext3) without reformatting.

Mount a partition (assign a drive letter) of any file system type to make it available for your operating system.

Modify file system parameters (make active/inactive, hide/unhide, etc.).

Install New OS Wizard to make a system ready to install a new operating system.

Undelete Partitions Wizard to recover an accidentally deleted partition.

File System Optimization Facilities

27 defragmentation strategies available to defragment FAT and NTFS file systems.

Safe Defragmentation Mode to guarantee data loss free defragmentation of any version of NTFS and FAT.

Low free space defragmentation (less than 1% of the free space required) to successfully defragment almost full
disks.

Auxiliary Facilities

File Transfer Wizard to make such operations as transferring of files/directories or burning of them to CD/DVD
as easy and convenient as possible. Providing access to Paragon backups as regular folders, it may also help to
replace corrupted data from a previously created image in case of an operating system failure.

A File Transfer Wizard is only available for the bootable recovery environment.

Volume Explorer is a handy tool when you have different file systems on the disk, whether they contain an

operating system or just data. Volume Explorer will let you explore a file system of any type and provide access
to the necessary files and directories regardless of their security attributes.

Recovery Media Builder to create a bootable recovery media on a CD, DVD disc, or flash memory, which can

later be used to boot and recover your computer in case of an operating system failure. Moreover, with its help
you can save data from partitions of your hard disk directly to compact discs or burn ISO-images. The utility
supports various formats of laser discs: CD-R/RW, DVD-R/RW, DVD+R/RW, DVD-R, DVD+R double layer, Blu-ray
and can handle multi-session burning.

Network Configuration Wizard to establish a network connection on a bootable recovery media either to save a
backup of a partition/hard disk or just several files on a network computer or retrieve a previously made backup
from a network computer for recovery purposes.

Boot Corrector to fix most of the system boot problems that can be a result of a human factor, program error or
a boot virus activity.

Copyright© 1994-2011 Paragon Software Group. All rights reserved.



A Boot Corrector is only available for the bootable recovery environment.

Supported Technologies

Along with using innovative technologies from outside, Paragon has developed a number of its own original
technologies that make its products unique and attractive for customers:

Paragon Hot Backup™ technology to back up locked partitions and hard disks under Windows NT+ family
operating systems providing both high operating efficiency as well as low hardware requirements.

Paragon Hot Copy™ technology to copy locked partitions and hard disks under Windows NT+ family operating
systems providing both high operating efficiency as well as low hardware requirements.

Paragon Power Shield™ technology to provide data consistency in case of a hardware malfunction, power
outages or an operating system failure.

Paragon UFSD™ technology to browse partitions of any file system including hidden and unmounted, modify
and copy files and folders, etc.

Paragon Hot Resize™ technology to enlarge NTFS partitions (system, locked) without rebooting Windows and
interrupting its work.

Paragon Smart Partition™ technology to securely perform hard disk partitioning operations of any complexity.

Paragon BTE™ technology to set tasks for execution during the system restart, thus saving from the need to use
a bootable media when modifying system partitions.

Microsoft Volume Shadow Copy Service (VSS) to provide the copy/backup infrastructure for the Microsoft
Windows XP/Vista/7/Server 2003/2008 operating systems. It offers a reliable mechanism to create consistent
point-in-time copies of data known as shadow copies. Developed by Microsoft in close cooperation with the
leading copy/backup solution vendors on the market, it is based on a snapshot technology concept.

GUID Partition Table (GPT). It is the next generation of a hard disk partitioning scheme developed to lift
restrictions of the old MBR. GPT disks are now supported by Windows Vista/7, Server 2008, Mac OS X and Linux.

Supported File Systems

Full read/write access to FAT16/FAT32 partitions.

Full read/write access to NTFS (Basic Disks) under Windows, Linux and PTS DOS. Compressed NTFS files are also
supported.

Full read/write access to Ext2FS/Ext3FS/Ext4FS partitions.

Limited read/write access to Apple HFS+ partitions.

A

Unfortunately, support of non-Roman characters for the HFS+ file system is unavailable at
the moment. The company is about to implement it in the nearest future.

Supported Media

Support of both MBR and GPT hard disks (2.2TB+ disks included)

Copyright© 1994-2011 Paragon Software Group. All rights reserved.
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e |DE, SCSI and SATA hard disks
e SSD (Solid State Drive)
e AFD (Advanced Format Drive)
e Non-512B sector size drives
e CD-R, CD-RW, DVD-R, DVD+R, DVD-RW, DVD+RW, DVD-R, DVD+R double layer and also Blu-ray discs
e FireWire (i.e. IEEE1394), USB 1.0, USB 2.0, USB 3.0 hard disks

e PC card storage devices (MBR and GPT flash memory, etc.)

Getting Started

In this chapter you will find all the information necessary to get the product ready to use.

Distribution
Paragon Partition Manager 11 is distributed in two ways:
e Boxed package from Paragon Software GmbH and resellers

e Downloadable package over the Internet at the company’s web-site

Distributive CD

The boxed package includes a distributive CD that is in fact a bootable recovery environment with auto-run of the
Windows installation, thus it can be used as a ready-made solution. But if you’re going to run the Windows components,
you need to install them first (see Installation).

If you want to download an update/upgrade of the product, it will be in form of the downloadable installation package
as described in Online Distribution).

Online Distribution

Partition Manager 11 purchased over the Internet will be in form of an MSI package. After installing the product you can
launch the Recovery Media Builder to prepare a recovery media.

Registration

Paragon Software GmbH provides a wide range of online services through its web-portal - www.paragon-
software.com/support/:

e Registration of new users;
e Registration of purchased products for registered users;

e Available around-the-clock downloading center, where registered users can get product updates/upgrades as
well as all the necessary documentation;

e Downloadable free demo versions and open documentation for all users.

A It is recommended to use Internet Explorer 5+ or any compatible browser.

Copyright© 1994-2011 Paragon Software Group. All rights reserved.
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To register as a new user

To register as a new user, please do the following:

1. Run an Internet browser and visit the page: www.paragon-software.com/my-account/;
2. Click Create of the Create a Paragon Account section;
3. Fill out a registration form;
4. Click Register.
The most important field in the form is an E-mail address, as it serves as a login to enter the system. Besides your access
password will be sent to this address as well.
To register a new product
If you are a registered user and would like to register Partition Manager 11, please do the following:

1. Run an Internet browser and visit the page: www.paragon-software.com/my-account/;

In the Email field of the Authorization section, enter an E-mail used for registration;

In the Password field enter a password received after registration;

2

3

4. Click Signin;
5. If the user name and password are valid, you will get to your account;
6. Click Register new product of the Products section;

7

Enter your product serial number in the Serial Number field. You can find it in the product box or obtain from
your reseller. Click Next;

8. On the next page you will be asked to provide some additional data. Also you will need to decide whether you
want to get confirmation on registering the product by E-mail or not. Click Next, and then click Finish.

That is all. The product is now registered.

How to Download Updates/Upgrades
Downloading of updates/upgrades can be fulfilled in the following way:

Run an Internet browser and visit the page: www.paragon-software.com/my-account/;

In the Email field of the Authorization section, enter an E-mail used for registration;
In the Password field enter a password received after registration;

Click Sign in;

If the user name and password are valid, you will get to your account;

Select My Downloads of the Products section to see what updates are available for you;

N o v ok~ w N

Select the desired update and click Download.

Contacting Paragon Software GmbH

If you have any questions about the company products, please do not hesitate to contact Paragon Software GmbH.

Service Contact

Visit Paragon Software web site WWwWw.paragon-software.com

Registration & updates web-service www.paragon-software.com/support
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Knowledge Base & Technical Support kb.paragon-software.com

Pre-sale information sales@paragon-software.com

System Requirements
For the Windows installation package
e Operating systems:
- Windows 2000 (32 bit only)
- Windows XP (32 and 64 bit)

- Windows Vista (32 and 64 bit)
- Windows 7 (32 and 64 bit)

e Internet Explorer 5.0 or higher

e Intel Pentium CPU or its equivalent, with 300 MHz processor clock speed
e 128 MB of RAM (256+ recommended)

e Hard disk drive with 250 MB of available space

e SVGA video adapter and monitor

e Keyboard

e Mouse

A During the installation additional free space (up to 1GB) will be required.

For the Linux bootable environment

Intel Pentium CPU or its equivalent, with 300 MHz processor clock speed
e 256 MB of RAM
e SVGA video adapter and monitor
e Keyboard
e Mouse
Additional requirements
e Network card to send/retrieve data to/from a network computer
e Recordable CD/DVD drive to burn data to compact discs

e External USB hard drive to store data.

Installation

To install Paragon Partition Manager 11, please do the following:
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1. Run Setup Application. Click on the *.MSil file. This application will guide you through the process of the

program installation. The setup utility is compiled with the InstallShield SDK, hence it contains the standard user
interface and set of installation steps.

In case there is some previous version of the program installed on the computer, the
program will offer the user to uninstall it first.

Starting Setup. The Welcome page informs that the application is being installed. Click the Next button to
continue.

Confirm License Agreement. The License Agreement page displays the Paragon License Agreement. Read the
agreement and then select the appropriate option to accept. If you do not agree with any conditions stated
there, the installation process will be interrupted. By clicking the Print button, the License Agreement may also
be printed out.

Provide Registration Information. On the Registration page you are to provide your product key and serial
number.

Provide Customer Information. On the Customer Information page you are to provide the standard
information, i.e. a user name and an organization. Besides you need to decide whether to make the program
available for all users of this computer (if several) or only for the current one.

Select an Installation Folder. The Destination Folder page allows you to choose a folder where the program will
be installed. By default, the installation folder will be created as:

C:\Program Files\Paragon\Paragon Partition Manager 11. To select another folder, click the Change... button.

After you have selected the required folder, click the Next button to continue.

Do not install the program on network drives. Do not use Terminal Server sessions to install
and run the program. In both cases, the program functionality will be limited.

Confirm Installation. On the Ready to Install the Program page click the Install button to start the installation or
the Back button to return to any of the previous pages and modify the installation settings.

Copying Files. The Copying Files page shows the overall progress of the installation. Click the Cancel button to
abort the setup.

Finishing the Installation. The Final page reports the end of the setup process. Click the Finish button to
complete the wizard.

To accomplish online operation on locked partitions/hard disks the program uses a kernel
mode hotcore driver, thus the system reboot is required to complete the installation
procedure.

First Start

To start Paragon Partition Manager 11 under Windows, please click the Windows Start button and then select Programs
> Paragon Partition Manager™ 11 > Paragon Partition Manager™.
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The program provides wide opportunities in the field of hard disk structure modification, so
A just to be on the safe side, please make a backup of your data before carrying out any
operation.

The first component that will be displayed is called the Express Launcher. Thanks to a well thought-out categorization
and hint system, it provides quick and easy access to wizards and utilities that we consider worth using on a regular
basis. With its help you can also start up the traditional launcher, the help system or go to the program’s home page.

@ Paragon Partition Manager™ 11 Personal ] @ s
Paragon Partition Manager ™11 G
ParaGcon
Personal > )S
eI SOlla
Partitioning Partitioning
What would you like to do?
Copying and
N b # Create Partition
gration .
Crazte a new pantition and set s properties
FL Backup and Rescue # Delete Partition
’ & Delete existing partiion and all data ¢ contans
.L'.--_l Boot Management # Resize Partitions
u . Move border of adacent partitions of the same type (both logical or both pamary) to
redistribute space between them. Note: this wizard covers only basic resize scenanos,
f resize operation cant be camed out with Express Resize Wizard, please switch to
@ Partition Manager gxmpw.mﬁmammwkuomu
# Merge Partitions
Support Contacts & Merge two adjacent partiions with the same file system and the same type (pimary to
primary oc logical to logical)
# Log Saver
. Prepare operation log files to send to Paragon’s support team
© Help

To know more on how to handle the product’s interface and accomplish typical operations,
please consult the Windows Components chapter.

Building Recovery Media
Recovery Media Builder can help you accomplish the following operations:

e Prepare the Linux/DOS recovery environment (included in the installation package) on external media (CD, DVD,
or flash memory) to boot and run utilities under Linux or PTS DOS, and that way to get access to your hard disk
for maintenance or recovery purposes (strongly recommended);

e Prepare a custom Linux/DOS recovery environment by adding any data you like to the standard image;

e Create from the master CD the Linux/DOS recovery environment on a CD/DVD disc, or flash memory.
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Booting from the Linux/DOS Recovery Media

The Linux/DOS recovery environment can be used to boot your computer into Linux or PTS DOS to get access to your
hard disk for maintenance or recovery purposes. It also has the PTS DOS safe mode, which may help in a number of non-
standard situations such as interfering hardware settings or serious problems on the hardware level. In this case, only
basic files and drivers (such as hard disk drivers, a monitor driver, and a keyboard driver) will be loaded.

Startup

To start working with the Linux/DOS recovery environment, please take the following steps:

1. Start up the computer from our Linux/DOS recovery media.

Recovery Media Builder can help you prepare our recovery environment either on a

E CD/DVD disc or a thumb drive.
To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Launch a boot mode you need (Normal, Safe, Low-Graphics Safe) in the Boot menu.

A By default the Normal Mode will be automatically initiated after a 10 second idle period.

3. Click on the required operation to start. Hints on the selected at the moment item will help you make the right
choice.

4. Consult the help system by pressing ALT+F1 to know more on the subject.

Boot menu

The Boot menu contains the following commands:

-+ Hormal Hode Main recovery
& Safe Mode enyironment

& Low-Graphics Safe Mode

& Floppy disk

& Hard disk 8 MBR

& Find 05es on your hard disks

e Normal Mode. Boot into the Linux normal mode. This mode uses the full set of drivers (recommended);

e Safe Mode. Boot into the PTS DOS mode. This mode can be used as an alternative of the Linux normal mode if it
fails to work properly;

e Low-Graphics Safe Mode. Boot into the PTS DOS safe mode. In this case, only the minimal set of drivers will be
included, like hard disk, monitor, and keyboard drivers. This mode has simple graphics and a simple menu;

e Floppy Disk. Reboot the computer from a system floppy disk;

e Hard Disk 0. Boot from the primary hard disk;
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o Find OS(s) on your hard disks. The program will scan hard disks of your computer to find any bootable operating
system.

To move within the menu, please use the arrow keys of the computer keyboard.

While working with the recovery environment you might experience some inconvenience
caused by possible video artifacts. It is just a result of changing video modes and in no way
will affect the program functionality. If this is the case, please wait a bit and everything will
be OK.

Normal Mode

When the Normal mode is selected, the Linux launch menu appears:

You can create, delete and format hard disk

Paragon Partition Manager™ partitions using Paragon Partition Manager™
which will start now. Upon the stan, please
Restore Wizard select the drive and one of its partitions or its

free space. Then actvale the Parition’
_ _ pull-down menu and select one of the
File Transfer Wizard partitioning operatons.

» e+ £F

\

Boot Corrector

Metwork Configurator

Log Saver

View the mounted partitions
Stan the command line
Eject CD/DVD

Reboot the computer

Power off

O™ BoiBxE,

Partition Manager (enables to run wizards and dialogs, to specify program settings, to visualize the operating
environment and the hard disk configuration);

e Restore Wizard (allows restoring hard disks and partitions);

e File Transfer Wizard (allows coping files/folders to another disk or a partition as well as recording them to
CD/DVD);

e Boot Corrector (helps to correct the Windows System Registry without Windows being loaded);

o Network Configurator (enables to establish a network connection under Linux);

If you are going to use network resources, first launch the Network Configuration Wizard to
establish a network connection.

e Log Saver (helps to collect and send the necessary log files to the Technical Support);
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o View the mounted partitions (the list of all mounted partitions will be displayed);

DOS, i.e. one after another, primary partitions at first. Thus mounted partitions may have

: The Linux/DOS recovery environment assigns drive letters to partitions the way it is done in
different drive letters from Windows.

e Eject CD/DVD;

e Command Line (allows experienced users to execute any operation);
o Reboot the computer;

e Power off the computer.

To move within the menu, please use the arrow keys of the computer keyboard.

Safe Mode

When the Safe mode is selected, the PTS DOS launch menu appears. It has nearly the same functionality as for the
Normal mode except for the Network Configurator and Log Saver commands. Besides due to certain limitations of the
PTS DOS environment, there is no possibility to burn CD/DVD discs.

Low Graphics Safe Mode

When the Low Graphics mode is selected, the PTS DOS launch menu appears. It has the same functionality and looks
similar to the Safe mode but graphically simpler.

g Partition Manager 11 You can create, delete and

# Sinple Restore Hizard format hard disk partitions
HE File Transfer Hizard using this program, which
& Boot Corrector will start now.

Upon the start, please
M Start the command line zelect the drive and one of
# Reboot the computer its partitions or its free

space. Then activate the
'Partition’ pull-down menu
and select one of the
partitioning operations.

Basic Concepts

This chapter explains terms and ideas that show how the program works. To understand these helps to obtain a general
notion of the operation performance and makes it easier for the user to operate the program.

System and Data Protection

The data protection issue is a growing cause of worrying for more and more people today. Indeed, it is hardly to find a
person who will be particularly happy when all precious information on the hard disk is irreversible lost as a result of its
malfunction. So how this tragedy can be prevented?
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Backup Storage

Our program supports several techniques of storing backup images. Let’s take a closer look at them all to understand
what kind of storage is able to provide better security:

e You can place a backup image to a local partition. Despite the fact that it is the most convenient way, try not to
use it. You can delete your backup just by accident or lose it as a result of a hardware malfunction, or a virus
attack;

e You can place a backup image to an external mounted storage to provide for a higher level of data protection
and system independence;

e You can place a backup image to a network drive to stand a better chance of success in case of a hard disk
failure. Moreover, by storing it on a special-purpose server you may be pretty sure nothing will happen to it.

Paragon Hot Processing & Volume Shadow Copy Service

Offline versus Online Data Processing

In the course of time there have been developed various methods of data processing. Despite different work concept,
all of them can be divided into two principal groups: offline (cold) and online (hot) data processing techniques.

As the name infers, offline data processing can only be accomplished when the data is in consistent state (the operating
system and all the applications are completely shut down). Actually it is the most preferable way of image creation or
data cloning, since software can obtain an exclusive right to process data that guaranties high level of operating
efficiency. However, the offline data processing is absolutely out of question when dealing with 24/7 production
environments.

In contrast, online data processing enables to create a consistent snapshot even as the data is currently modified. It is
particularly useful for systems with high availability requirements, but it won’t be accomplished until all active
transactions are complete. The point is to provide a coherent state of all open files and databases involved in a process,
taking into account that applications may still keep writing to disks. As a result an online data processing cannot boast
high operating speed.

Our program supports both offline and online methods of data processing. As far as online method is concerned it offers
its own hot processing algorithm together with the possibility to use snapshot technologies provided by the Microsoft
VSS framework.

Paragon Hot Processing Technology

Paragon Hot Processing is an online copy/backup technology for Windows NT+ family operating systems. Developed
back in 2001, nowadays it is integrated with all copy/backup solutions offered by the company.

Paragon Hot Processing is not exactly a snapshot technology, though it has much in common with it. During an online
copy/backup, the program uses the kernel mode driver HOTCORE.SYS to intercept and control disk write activity of
applications and the operating system. The hotcore driver as an integral part of the program is installed during the setup
procedure (that’s why the system reboot is required to complete the setup procedure). For the most part the driver is in
the idle mode until it is activated with the program. While in this mode it bypasses any calls having no effect on the
overall system performance, but a few kilobytes of the system memaory.

Paragon Hot Processing technology offers copy/backup of locked partitions and hard disks under Windows NT+ family
operating systems providing both high operating efficiency as well as low hardware requirements.
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Volume Shadow Copy Service

Microsoft Volume Shadow Copy Service (VSS) is designed to provide the copy/backup infrastructure for the Microsoft
Windows XP/Vista/Server 2003/2008 operating systems. It offers a reliable mechanism to create consistent point-in-
time copies of data known as shadow copies. Developed by Microsoft in close cooperation with the leading
copy/backup solution vendors on the market, it is based on a snapshot technology concept.

Initiated by a VSS aware copy/backup utility, VSS creates snapshots for the selected volumes and represents them as
virtual read-only devices, called volume shadow copies. Once the shadow copies are created, the copy/backup utility
starts processing the data while applications keep writing to original volumes.

Unlike Paragon Hot Processing the VSS technology provides a unique possibility to make a synchronous snapshot of
multiple volumes. This very feature can be particularly beneficial when backing up active SQL Server 2003, Exchange
2003 or Oracle databases located on multiple volumes the way it is recommended by Microsoft to improve the level of
database performance and reliability, thus providing 100-percent data consistency.

A To use VSS it is necessary to have a mounted 300 MB+ NTFS partition.

GPT versus MBR

GUID Partition Table (GPT) is the next generation of a hard disk partitioning scheme developed to lift restrictions of the
old MBR. Being a part of the Extensible Firmware Interface (EFI) standard proposed by Intel to replace the outdated PC
BIOS, it offers a number of crucial benefits:

e Up to 128 primary partitions for the Windows implementation (only 4 in MBR);
e The maximum allowed partition size is 18 exabytes (only 2 terabytes in MBR);
e More reliable thanks to replication and cyclic redundancy check (CRC) protection of the partition table;

o A well defined and fully self-identifying partition format (data critical to the platform operation is located in
partitions, but not in un-partitioned or hidden sectors as this is the case with MBR)

To tackle compatibility problems with older operating systems there has been introduced a special combined GPT+MBR
partitioning scheme called Retained GPT (also known as Hybrid GPT), where the first three partitions except for EFl (GPT
service partition) are synced between GPT and MBR. This synced partition map provides an avenue, for instance for
booting 32-bit Windows Vista/7 on computers controlled by the old BIOS. It’s also used for dual booting Mac OS X and
Windows on a GPT disk.

Apple Boot Camp

Boot Camp is a special utility to help you set up a dual boot system (Mac OS X and 32-bit Windows XP/Vista) on Intel-
based Macs. It enables to securely re-partition your hard disk (resize an existing HFS+ partition to create a separate
partition for Windows) and then launch the installation process. With Boot Camp all the necessary drivers will be at your
disposal. Moreover after Windows has been installed it will serve as a boot manager to choose what operating system
to start up.

It is strongly recommended not to modify the hard disk configuration with Windows Disk
Manager. Otherwise it may lead to unexpected consequences, right up to BSOD and
inability to boot in Windows XP/Vista. Please use our program to correctly update both
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MBR and GPT.

64-bit Support

The bulk of software today is written for a 32-bit processor. It can meet the requirements of almost any end user.
However that is not the case when dealing with servers processing large amounts of data with complex calculations of
very large numbers. That is where 64-bit architecture comes into play.

It can boast improved scalability for business applications that enables to support more customer databases and more
simultaneous users on each server. Besides a 64-bit kernel can access more system resources, such as memory
allocation per user. A 64-bit processor can handle over 4 billion times more memory addresses than a 32-bit processor.
With these resources, even a very large database can be cached in memory.

Although many business applications run without problems on 32-bit systems, others have grown so complex that they
use up the 4 GB memory limitation of a 32-bit address space. With this large amount of data, fewer memory resources
are available to meet memory needs. On a 64-bit server, most queries are able to perform in the buffers available to the
database.

Some 32-bit applications make the transition to the 64-bit environment seamlessly others do not. For instance, system-
level utilities and programs that provide direct hardware access are likely to fail. Our program offers a full-fledged
support of the 64-bit architecture providing fault-tolerant work for such system dependent modules as Hot Processing.

Copy Operations

Hard drive duplication nowadays is becoming highly popular among PC users. That is due to some definite advantages it
can offer. First of all, many people clone hard disks just to back up data for security reasons. The present day copy
utilities enable to successfully transfer all on-disk information including standard bootstrap code and other system
service structures, thus maintaining the operating system’s working capability. In case of a system malfunction, the user
can get the system back on track in minutes. No additional configuration is required, what is very convenient.

The second possible application is the upgrade of a hard disk to a new one. The capacity of a modern hard drive doubles
every two years, thus opening up new possibilities for software developers. As a result programs become more
complicated and require considerable amount of free space. One day the user realizes that there is no more free space
left on the hard disk and the only way out is to upgrade. Usually that means that besides purchasing a new hard disk,
the user is to face a large re-installation procedure spanning several days of tedious work. But all of this can be avoided
just by copying the contents of the old hard disk to a new one proportionally resizing the partitions.

And the last but not least is the copying of hard disks for cloning purposes. It may be of great use when setting up
similar computers. There is no need for a system administrator to install an operating system from scratch on every one
of them. It is enough just to configure one and then clone it to the others.

Drive Partitioning

As you probably know a hard drive is to be split into one or more partitions, since it cannot hold data until it is carved up
and space is set aside for an operating system. Until recently most PCs used to have just one partition, which filled the
entire hard disk and contained an OS. The situation has changed however, thanks to new cost-effective high capacity
hard drives, thus opening up numerous possibilities for PC users, such as editing video, archiving music, backing up CD
images, etc. Huge increase in space is great, but it poses a number of problems, most important of which are effective
data organization and speed.

Large drives are always going to take longer to search than smaller volumes, and an operating system is going to have its
work cut out both finding and organizing files. It is for this reason that many people decide to invest in multiple hard
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drives, but there is an easy solution — drive partitioning. Partitioning lets you divide a single physical drive into a number
of logical drives, each of which servers as a container with its own drive letter and volume label, thus enabling the
operating system to process data more efficiently. Besides partitioning makes it possible to organize data so that it is
easy to find and manage. You can set aside, for instance, 40 GB of a 160 GB hard drive for the OS, 70 GB for storing
video and another 50 GB for your favorite music collections to provide transparent data storage.

It is also worth mentioning to that with a hard drive properly partitioned, such routine operations as files de-
fragmentation or consistency check will not be that annoying and time-consuming any more.

By detaching the OS from the rest of the data you can tackle one more crucial issue — in case of a system malfunction,
you can get the system back on track in minutes by recovering it from a backup image located on the other partition of
the hard drive.

But that is not all drive partitioning may be used for. If you are willing to play games in Windows while browsing the
Internet in Linux, 100-percent sure that no virus will attack your PC, drive partitioning is a necessity. In order to run
several OSs on a single hard drive you are to create a corresponding number of partitions to effectively delineate the
boundaries of each OS.

Windows Components

In the given section you can find all the information necessary to successfully work with the Windows version of the
product.

Interface Overview

This chapter introduces the graphical interface of the program. The design of the interface precludes any mistake being
made on the part of the user. Most operations are performed through the system of wizards. Buttons and menus are
accompanied by easy understandable icons. Nevertheless, any problems that might occur while managing the program
can be tackled by reading this very chapter.

General Layout

When you start the program, the first component that is displayed is called the Launcher. It enables to run wizards and
dialogs, to specify program settings, to visualize the operating environment and the hard disk configuration.

The Launcher’s window can be conditionally subdivided into several sections that differ in their purpose and
functionality:
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A number of panels offer similar functionality with a synchronized layout. The program enables to conceal some of them
to simplify the interface management.

All panels are separated by vertical and horizontal expandable sliders, allowing the user to customize the screen layout.

Main Menu

The Main Menu provides access to the entire functionality of the program. The available functions are as listed below:

MENU ITEM FUNCTIONALITY

Tools

View Log Files View logs on the carried out operations

Send Log Files Compress and send the log to the Paragon Support Team

Setup Boot Manager... Manage several operating systems on one computer

Recovery Media Builder... Restore the system even when the current operating system cannot boot
anymore

Settings... Edit the general settings of the program

Exit Exit the program

Changes

Undo “the last virtual Cancel the last virtual operation on the List of Pending Operations

operation’

Redo “the last virtual Cancel the last undo virtual operation on the List of Pending Operations

operation’

View Changes... Display the List of Pending Operations

Apply Changes Launch the real execution of virtual operations

Discard All Changes Cancel all virtual operations on the List of Pending Operations

Reload Disk Info Refresh the current information about disks

Wizards

Express Create Partition... Create an NTFS partition and make it ready for work

Create Partition... Create a partition of any file system

Format Partition... Format a partition of any file system

Delete Partition... Delete a partition of any file system

Express Resize Partitions... Increase free space on one partition by up-taking the unused space of an
adjacent partition

Undelete Partitions... Recover an accidentally deleted partition
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Merge Partitions...

Merge adjacent partitions of NTFS, FAT or FAT32 file systems

Redistribute Free Space...

Redistribute available disk space of existed partitions

Install New OS...

Make your system ready to install a new operating system

Simple Backup...

Create a sector-based archive of an entire hard disk or separate partitions

Copy Hard Disk...

Create a hard disk copy

Copy Partition...

Create a partition copy

Hard Disk
Update MBR Update MBR (Master Boot Record) of the selected hard disk
Edit/View Sectors... View/edit sectors of the selected hard disk

Properties...

Get in-depth information on the properties of selected hard disk

Partition

Create Partition...

Create a partition

Format Partition...

Format a partition

Delete Partition...

Delete a partition

Move/Resize...

Move/Resize the selected partition

Convert File System...

Convert file system of the selected partition

Assign Drive Letter...

Assign drive letter to the selected partition

Remove Drive Letter...

Remove drive letter for the selected partition

Hide Partition...

Make the selected partition unavailable for the operating system

Unhide Partition...

Make the selected partition available for the operating system

Mark Partition as Active

Make the selected partition bootable by default

Mark Partition as Inactive

Make the selected partition non-bootable by default

Change Volume Label...

Change volume label of the selected partition

Make Partition Primary...

Make the selected partition Primary

Make Partition Logical...

Make the selected partition Logical

Defragment Partition...

Defragment data on the selected FAT or NTFS partition

Test Surface...

Test surface of the selected partition/block of free space

Check File System
Integrity...

Check the selected partition for possible file system errors
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Edit/View Sectors...

View/edit sectors of the selected partition

Properties...

Get in-depth information on the properties of selected partition

View

Layouts Manage the Launcher layout with several predefined profiles

Toolbar Manage the Tool Bar representation: show / hide standard and navigation
buttons, text labels and large icons

Status Bar Display the Status Bar

Common Tasks Bar

Display the Common Tasks Bar

Disk Map Legend

Display the Disk Map legend

Properties and Commands

Display the Explorer Bar

Disk Map Location Select whether the Disk Map will be located on the top of the main window or
at the bottom

Help

Help Open the Help system (you can also do it by pressing F1)

About Open the dialog with information about the program

e The Main Menu contents available at the moment may vary depending on the selected

object.

Tool Bar

The Toolbar provides fast access to the most frequently used operations:

BUTTON FUNCTIONALITY

adjacent partition

@g Create an image of a hard disk or
partition

(e Increase free space on one partition
e by up-taking the unused space of an

Copy a hard disk

Defragment the selected partition

.-1

‘6

-

-

@ Switch to Express launcher
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T

Open the Help system

Virtual Operations Bar

The program supports previewing the resulting layout of hard disks before actually executing operations (so-called

virtual mode of execution). In fact, when the virtual mode is enabled, the program does not accomplish operations

immediately, but places them on the List of Pending Operations for later execution.

The Virtual Operations Bar enables to manage pending operations.

BUTTON FUNCTIONALITY

5

Cancel the last virtual operation on the List of Pending Operations

@‘a

Cancel the last undo virtual operation on the List of Pending
Operations

Display the List of Pending Operations

&

Launch the real execution of virtual operations

X

Cancel all virtual operations on the List of Pending Operations

A

Virtual mode is an effective way of protection from any troubles, since no operations will
be executed until clicking the Apply button for confirmation, thus giving a second chance to
weigh all pros and cons of this or that particular operation. The program politely reminds
the user that there are unsaved changes by showing the following window:

‘1 There are unsaved changes.

Please use the 4 Apply command to commet the changas and the ® Discard
command 1o permanently undo the changes,

You can view the changes history via the “. View Changes command and

lempotaiymdootredomeooewtmbymemd!h") Undo and O Redo
commands:

Common Tasks Bar

The Common Tasks Bar is located on the left side of the main window. It is intended for easy access to the program's

wizards.

The bar contains several tabs. Each tab includes a separate button bar which can be folded by clicking it.

Basic Partitioning Tasks

@3 e Starting the Express Create Partition Wizard to create an NTFS partition and make

it ready for work.

@ Create Partition Starting the Create Partition Wizard to create a partition of any file system.
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@g Format Partition

Starting the Format Partition Wizard to format an existing partition to one of the
file systems supported by the program.

oz
% Delete Partition

Starting the Delete Partition Wizard to delete a partition of any file system.

Advanced Partitioning Tasks

&

[ =]
k= Express Resize

Starting the Express Resize Partitions Wizard to redistribute free space between
two adjacent partitions.

=]
Qf_\:“- Merge Partitions

Starting the Merge Partitions Wizard to merge adjacent partitions of NTFS, FAT,
FAT32 file systems.

ﬁ Redistibite Free Space

Starting the Redistribute Free Space Wizard to redistribute available disk space of
existing partitions.

[
‘@ Undelete Partitions

Starting the Undelete Partitions Wizard to recover accidentally deleted partitions.

Copying Tasks

[‘(:;r | Copy Disk

Starting the Copy Hard Disk Wizard to copy a hard disk.

£
(=2 Copy Partition

Starting the Copy Partition Wizard to copy a partition.

Backup Tasks

ﬁ-'; Back up Disk or Partition

Starting the Sector Backup Wizard to create an archive of a hard disk or separate
partitions.

Tools

E!I Boot Manager Wizard

Starting the Boot Manager Setup Wizard to easily manage several operating
systems on one computer.

h.:r Install new OS5 wizard

Starting the Install New OS Wizard to install a new operating system.

Help and Documentation

-
Y\ g Partition Manager™ Help

Launching the help system (you can also do it by pressing F1).

'\ﬁ About Partition Manager™

Opening the page which contains information about the program. This page will
be displayed in the Explorer Bar.

Disk Map

The Disk Map is displayed in the Explorer Bar when the Disk View tab is selected. It is located either at the top or at the

bottom of the window, depending on the state of the Disk Map Location option (Main Menu: View > Disk Map

Location).
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As the name infers, the Disk Map displays the layout of physical and logical disks. Physical disks are represented with
rectangle bars that contain small-sized bars. These small-sized bars represent logical disks. Their color depends on the
file system of the appropriate partition.

= B |

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev) -

Local Disk (C:)
4399 GB NTFS
Large-sized bars display the following information about physical disks:
e Manufacturer,
e Model.
Small-sized bars display the following information about logical disks:
e Serial number,
e Drive letter,
e Total size,
e File system.

Furthermore, it is possible to estimate the used disk space by looking at the size of the bar’s shaded area. The program
offers to choose from several types of the disk layout scaling. It's done especially to increase the program usability. For
instance, if you’ve got a high capacity hard drive containing both very large (more than 100 GB) and rather small (less
than 10 GB) partitions, you can select the logarithmic type to make all partitions readable, otherwise (selecting the
linear type) you won’t be able to see small partitions at all, but thing strips. On the other hand, if the proportional disk
layout is critical for you, the linear type is exactly what you need.

Nevertheless there’s a compromise solution — linear scaling with the minimal limit to small partitions. So if a partition is
too small it will remain readable.

Just click on the arrow icon on the top right side of the Disk Map to select the desired scaling type.

I | |

v Linear
Limear S5caling Min Width

N

=

Lirnee Ext4 ReiserFS

Disk Map is synchronized with the Explorer Bar. Thus by selecting a disk on the Disk Map, the Explorer Bar will
automatically display detailed information on it.

The drag-and-drop functionality is not available when the logarithmic type of the disk
layout is selected.

Explorer Bar

The Explorer Bar is located in the center of the main window which emphasizes its importance. The bar displays
reference information including:

e The help system

e General information on the product including its name, version and a list of helpful links
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e Detailed information about disks selected on the Disk Map
e Volume Explorer utility
e Disk Editor utility
According to these categories the Explorer Bar has several tabs:
e Disk View, which offers the user the following options:
- Partition List to get a clear-cut picture of the current state of the system hard disks/partitions
- Disk Editor to view/edit sectors of the selected partition/hard disk

- Volume Explorer to browse and export contents of the selected partition/hard disk

- Properties to view detailed information on the selected partition/hard disk in the bright graphical form

Q You can switch between these components by clicking tabs on the left side of the Explorer
Bar.

e Help, which contains the program help and general information on the product.
You can access the desired information by clicking on the appropriate tab.

The Explorer Bar is a fully-functional embedded HTML browser, which offers the possibility to address, for example, the
company's website to look through important technical notes or download the latest updates without having to close
the program.

The program help is also HTML-oriented. You can read it and follow external links from to get additional information.

To easily navigate through browsed pages, the program provides the following functionality:

BUTTON FUNCTIONALITY

'-:t;!." Return to the previously browsed
page

Gy Open the next browsed page

(> p pag

o Stop loading the current page

Refresh the contents of the current
page

Partition List

The Partition List is another helpful tool that enables you to get a clear-cut picture of the current state of the system
hard disks/partitions. Partitions are sorted according to their starting position. For every item of the list there is the
possibility to call the context-sensitive popup menu with available operations. Besides, the program provides detailed
information on all hard disks/partitions found in the system including the following properties:

- Name,
- Volume label (if exists),

- Partition type (Primary/Extended /Logical),
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- File system type,
- Size,
- Amount of used and unused (free) space,
- Start/End cylinder,
- Start/End head,
- Start/End sector
- Free size in sectors/bytes
- Active/Inactive attribute
- Hidden/Unhidden attribute

You may customize outlook of the Partition List by clicking on the arrow icon on the top right side of the panel.

Please select properties to display.

Please select properties you would Biee to display in the Disks and Partitions view
Mame
Size pectors)
F5 Size {sactors) Move down
Usad [sactors)

Start (seciors)

End {sactors)

Start CHS )

End CHS fhex)

] File systam

| Viokusne label

| Partkion size
] Size
] Usad

| Free fepctons)
] Active
] Hiddan

] Letter

1 . 1]
Pastiion D

Jioe] (][] ] [ (] [ [

| Sactiom per Cluster
] Siet

By marking a checkbox opposite the required item you can choose whether to display it or not. Besides, you can change
its order by pressing the Move up or Move down buttons.

If you don’t need the Disk Map, please click the shown below icon to disable it:

Stant fsectors) | End [sectons) | Stad CHSheot) | Bvd CHShex)

800h 235F8 P 020 21 20<D BY 14
235FE300h  GETFEFFFh 904D 1 15 FEFE 94 1E
300h  IETFEFFA 02021 FEFE 34 IE

Properties Bar
The Properties Bar provides information on the selected at the moment partition/hard disk:

For a hard disk
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e Model,
e Serial number,
e Type of hard disk (basic or dynamic),
e Total size (in GB),
e Information on geometry of the disk (amount of sectors per track, heads and cylinders).

For a partition

Drive letter assigned to the disk,

e Volume label (if available),

e Type of the logical disk,

e File system (represented by the color of the graph and the selected bar),
e Total size, used space and free space (in GB or MB).

Besides you can modify practically any partition property by clicking on the required value.

Legend Bar

The Legend Bar explains the color scheme used for disk and partition presentation. You can hide (or show) the bar with
the appropriate Main Menu item: View > Disk Map Legend. When it is activated it can be found at the bottom of the

Explorer Bar.

The program distinguishes between the following types of known file systems:
- FAT16/32
- NTFS
- Linux Ext2/3/4
- Linux ReiserFS

- Apple HFS

Status Bar

This is the bottom part of the main window. The Status Bar displays menu hints, for each item the cursor points to.

The user can hide (or show) the bar with the appropriate Main Menu item: View > Status Bar.

Settings Overview

The Settings dialog is available from the Main Menu: Tools > Settings. All the settings are grouped into several sections,
which functions are described in the following paragraphs. The list of sections is placed on the left side of the dialog. By
selecting a section from the list, you can open a set of options.

Q To get a detailed description to any setting, control, or field of the program just click the
hint button and then the object you need.
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{\g General options

Partition Abgrment Mode

Wista 3
Align partitions according to the nies usad in Windows Vista and later 05es.

Check: F5 integrity policy

Oz :!

Standard profection from data loss with acceptable pafomance. The file system
inbegrity will be checked for each volume only once just before accomplshing
data-sensiive operations

Data Loss Protection mods

32

Mediam protection from data loss

This section contains a set of general options that will be taken into account during any operation carried out with the

program:

Enable Initial Backup reminders. If this option is marked, the program will automatically offer to make a backup
before accomplishing any critical partitioning operation, thus minimizing the risk of data loss.

Partition Alignment mode. There are three options you can choose from:

Legacy. DOS and Windows OSes before Vista required that partitions had to be aligned to the “disk cylinder”
or 63 sectors to address and access sectors correctly. It was OK, until 4K hard drives came into scene. When
partitions are aligned this way on this type of disk, each logical cluster is linked to two physical 4K clusters,
thus resulting in a double read-write operation.

Vista. Since Windows Vista, operating systems do not use the archaic CHS (cylinder/head/sector) addressing
scheme, but the Logical Block Addressing (LBA), where sectors are addressed continuously over the whole
disk drive. It is optimal for both, 512B and new 4K disk drivers.

Inheritance. Select the option to disable automatic alignment of partitions.

Check FS integrity policy. Accomplishment of any data-sensitive operation (resize, move, merge, redistribute,

change cluster size, etc.) is potential with data loss. To minimize this risk, it's recommended to check integrity of
your file system before this type of operations, despite the fact that it’'s quite time consuming. We offer you
several options to let you choose, which is best for you:

Always. Maximum protection, but minimal performance. The file system integrity will be checked each time
it’s necessary to guarantee the maximum protection for the on-disk data.

Once. Standard protection with acceptable performance. The file system integrity will be checked for each
volume only once just before accomplishing data-sensitive operations.

Never. No protection, but maximum performance. If you’re not 100% sure your disk is rock solid, please do
not use this option.

Data Loss Protection mode. To guarantee safety for your information when a data-sensitive operation has been

abruptly interrupted as a result of a computer reset, or a power outage, there are several techniques, that
correspond to the options below:

Do not protect. No protection, but maximum performance. If you’re not 100% sure you’re completely safe
from a power outage, or an accidental reset of your computer, please do not use this option.
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- Reset. Standard protection with acceptable performance. Maintaining a special journal, our program
enables to automatically complete a data-sensitive operation interrupted by an accidental reset of your
computer from our bootable recovery media, thus reviving the corrupted partition.

- Power loss. Maximum protection, but minimal performance. Besides journaling, our program will also
disable cache of your disk when accomplishing data-sensitive operations to avoid data loss even in case of a

power outage.
General Copy and Backup Options

lzg General copy and backup options

Hdd raw processing

Copy an entire hard disk sector by sector without taking into account its partition
structure

Parttion raw processng

Copy/Backup each partition sector by sactor, All sectors will be processed one by
one (even unused sectors). Requires more time to complete the operation

V| Skip OS awdkary files
Choose this option to skip OS awdiary fies ke pagefile sys. hibedi sys etc ), This
will reduce operation time and backup image size

This section contains a set of options that will be taken into account during copy and backup operations:

e HDD raw processing. Mark the checkbox to copy/back up a hard disk in the sector-by-sector mode, thus
ignoring its information structure (e.g. unallocated space or unused sectors of existing partitions will be
processed as well). This can help to avoid problems with hidden data created by certain applications or the
system administrator. However, it will take more time to accomplish the operation.

e Partition raw processing. Mark the checkbox to copy a partition in the sector-by-sector mode to successfully
process unknown file systems. However it is not recommended to enable this option when working with
supported file systems as it takes more time to accomplish the operation.

e Skip OS auxiliary files. Mark the checkbox to skip OS aukxiliary files (like pagefile.sys, hiberfil.sys, etc.), thus
reducing the operation time and the resulted size of the backup image.

Hot Processing Options

V| Enable hot processing
Hot processing technology
Microsoft Volume Shadow Copy Service 3

Microsoft Volume Shadow Copy Service is a reliable technology designed to back
up volumes being locked by numerous active transactions of VSS supporting
appications. Microsoft VSS technology requires over 300 MB of free space on
any mounted NTFS volume for temporary data. This technology is provided for
Windows XP and newest Windows versions, but unavaidable for old versions of
Windows (S8/ME/NT/2000)
Addtional options
Always use hot processing

@ Use hot processing only when partion is locked
Hot processing temporary dive

¢ [+

Number of attempts to stat VSS: 3

Timeout between attempts §in seconds). 120 2

V| Switch between Hot Processing technologies

In this section you may configure the hot processing mode:

Copyright© 1994-2011 Paragon Software Group. All rights reserved.



34

e Enable hot processing. Mark the checkbox to enable the so called hot data processing mode that is specially
designed to process data without restarting your operating system.

o Hot processing technology. From the pull-down list you can select the required hot processing technology.

e Always use hot processing. Select the option to process partitions without making them locked. Thus you will
be able to keep working with them as usual.

e Use hot processing only when partition is locked. Select the option to use the hot processing only when
partitions are locked and cannot be processed without restarting the computer. Please keep in mind, that once
you start any operation on a partition in this mode, it will automatically be locked by the program, thus you
won't be able to keep working with it as usual.

o Hot processing temporary drive. Here you can select a disk drive that will be used to store the temporary hot
backup data (by default — C:).

e Attempts to start VSS. Here you can set how many attempts to start Microsoft VSS the program is to do before
automatically rebooting the system and accomplishing the operation in a special boot-up mode.

¢ Timeout between attempts (in seconds). Here you can set a time period between different attempts to start
Microsoft VSS.

e Switch between hot processing technologies. Mark the checkbox to automatically switch between Paragon Hot
Processing and Microsoft VSS if one of them is unavailable at the moment.

Partitioning Options

Enable 64 KB clusters for FAT16

Choose this option to enable 64 KB dusters for FAT 16 paritions. With this setting,
you will be able to create FAT 16 parttions with capacity up to 4 GB. Please note
that only Windows NT famiy systems will ba able to access such paritions

Confirmations
v, Ask for volume label before partition delete
Ask confimation when convesting FAT16to FAT32

This section contains a set of options that will be taken into account during partitioning operations:

e Enable 64 KB cluster size for FAT16. Mark the checkbox to enable 64KB clusters for FAT16 partitions. Thus you
will be able to create FAT16 partitions up to 4GB in size

Due to the maximum cluster size of 32KB for Windows 95/98/ME or MS DOS, FAT16
partitions larger than 2GB are not reliably accessible under these operating systems.

e Request confirmation before partition deletion. Mark the checkbox to activate an additional security
mechanism. Thus when going to delete a partition you will be automatically requested to enter its label.

e Request confirmation when converting FAT16 to FAT32. Mark the checkbox to automatically request
confirmation before converting FAT16 to FAT32. There are a number of situations when this kind of conversion
is the only way out to accomplish the operation. For instance, you are going to migrate your system to a larger
hard disk with the proportional resize of existing partitions, what is very convenient. As a result you can get
original FAT16 partitions go beyond the 4GB limit. Thus without conversion to FAT32, this operation will in no
way be possible to accomplish. The same goes for any copy hard disk/partition or restore hard disk/partition
operation involving an extra upsizing.
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E-Mail Options

Specily your e-mail account oplions:
Outgoing madl senver (SMTF)
User e-mail addrsss
SMTF port numbeear: 25
My outgoing sancer requines authentication

This section contains a set of options that will be taken into account during the Send log files and Send e-mail
notification operations:

e Outgoing mail server (SMTP). To send messages by using the built-in mail client, it is necessary to have access to
a computer running an SMTP (Simple Mail Transfer Protocol) server. All outgoing messages are first sent to the
SMTP server, which in its turn delivers them to the required recipients. The address may be represented as a
traditional Internet host name (e.g.: mail.com) or as an IP numeric address (e.g. XXX.XXX.XXX.XX).

e User e-mail address. Specify an e-mail address that has been assigned by the Internet Service Provider or
organization's e-mail administrator.

e My outgoing server requires authentication. Activate the option to allow the program to make authentication
on the server before sending messages.

- User name. Enter the name that will be used to log in to the e-mail account.

- Password. Enter the password that will be used to access the mail server.

Virtual Mode Options

Operations mode
7| Alow vitual mode
Set this option on to camy out al the operations vitually. You will be able to

commit the changes or rolback all of them or the last one. ¥ you switch this
option off, the operations will be camed out immediately

Closa progress dialog automatically
Set this option on to automatically close the progress dialog after commiting the
changes

In this section you may configure the virtual mode:

o Allow virtual mode. Mark the checkbox to enable the virtual mode. It is an effective way of protection from any
troubles, since no operation will be executed until confirmation, thus giving you a second chance to weigh all
pros and cons of this or that particular operation.

A We strongly recommend you to enable this mode.

e Close progress dialog automatically. Mark the checkbox to automatically close the progress dialog after
accomplishing operations.
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File System Conversion Options
(\\fg File system conversion options

Sedact a time zone

{GMT) Greenwich Mean Time; Dublin, Ednburgh, London, Lisbon (v
Select language for file names
Englsh {CP-850) v

This language wil be used to spacfy national symbols in file names

Confirm settings before NTFS <> FAT/FAT32 conversion

Choose this option to make the program to allow 10 customize these sattings each
time when converting file systems

This section contains a set of options that will be taken into account when converting FAT and NTFS file systems. By
default, the program takes locale (regional) settings from the system. Problems might occur however because of
different standards for file names and file time stamps (Created, Modified and Last Access Time) of NTFS and FATxx file
systems.

To tackle problems of that kind you can manually set:

e Time zone to use during the convert operation. NTFS keeps file timestamps in GMT (Greenwich Mean Time)
while FAT uses a fixed local date and time. The program takes proper account of these differences and enables
to adjust timestamp values.

A An incorrectly chosen time zone might lead to inability to launch certain software.

e Language for file names to use during the convert operation. NTFS stores file names in Unicode while
FAT/FAT32 uses ANSI to save short file names (also called the DOS aliases). The codepage information is
required for the correct conversion of non-English file names from Unicode to ANSI and vice versa.

An incorrectly chosen codepage will certainly result in corruption of non-English file
t : i names.

e Request confirmation of settings before NTFS < - > FAT/FAT32 conversion. Mark the checkbox to automatically
display the local settings dialog to check and modify (if necessary) the default parameters before launching the
convert file system operation.

Defragmentation Options

Defragmentation mode
Sefe mode recommendead) [=]

Slow but rediable. In this mode the program requires free space on the defragmented
ot the moment partition o guarantes protection of your data in case of a power
cutage, hardwane mafunction or a system faiure.

In this section you may set the preferable defragmentation mode:

e Fast mode. Partitions will be defragmented rather fast (a 10-30% gain depending on the fragmentation level),
but a power outage, hardware malfunction or a system failure during the operation might lead to the data loss.
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e Safe mode. To guarantee protection of your data during the operation, the program will allocate some free
space (not less than the on-disk largest file) on the defragmented at the moment partition to make a duplicate
of every processed file. Thus we strongly recommend you to use this very mode.

Log Files Options

“og Log files options

Chocse a storage e span for the stubact bog file. Please nate, once the defined pesiod

hias bean eqired, the fils will be smptied.
@ Ifinle

Marurnal
Custom

In this section you can specify a storage life span for the stubact.log file:
¢ Infinite not to empty the file ever;
e Minimal to have the file emptied all the time;

e Custom to set a certain storage life span for the file. Please note, once the defined period has been expired, the
file will be emptied.

We strongly recommend you not to choose the Minimal option, as in case of having
A problems with the program, our Support Team won’t be able to study operation logs, thus

help you out.

Viewing Disk Properties

The main tool to view in-depth information on the properties of hard disks is the Disk Map. It represents the actual state
of the computer’s hard disks.

Generally the hard disks are represented on the map by rectangular bars, which also contain small-sized bars. The small-
sized bars represent logical disks (partitions). When you select a large-sized bar, the Explorer Bar displays information
about the disk in a bright, graphical form.
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-

| Basic Hard Disk 1 (FUJITSU MPF3102AT)

‘ Type: Basic Hard Dick Drive
| Total size: 35GB
: Sectors per track: 63
Heads: 255
Cylinders: 1245

' Create an image of the e disk
Back up 3l the data this haed disk containg, All the paititions on this disk will be added to the archive.

Restore an image of the entire disk
Warning: This operation wil delete all the data on this haid disk. All the pattitions will be replaced with cnes from
the mage you have chosen. You may aleo be asked to restaet your computer during thes operation

(
re |

Copy the entire hard disk
Create a copy of the entire haed disk
Al the pastitions on this disk will be copiad on the specified targat disk.

£ &

The model and serial number of the disk serve as the title of the browsed page. The disk layout is shown in form of a
circular graph, where the color of a sector corresponds to a file system of an appropriate partition. On the right you may
see a table, which contains the following information:

e Type of hard disk (basic or dynamic),
e Total size (in GB),
e Information on geometry of the disk (amount of sectors per track, heads and cylinders).

Below there is a list of available wizards. If you click a corresponding record the appropriate wizard will be started. All
default values for the operation parameters will correspond to the disk’s settings. The list of wizards contains a detailed
description of tasks that can be performed by the wizard. This nullifies the possibility of selecting the wrong wizard.

' Logical Disk (G)

Volume letter: [G:) Seral number: 7493E48F
Volume label: FAT32-LINLX Partition ID: 008 FAT32
Type: Primary Total size: 68GB
File system;: FAT32 Used space: 57GB
Sectors per boot: 36 Free space: 1GB
Sectors per cluster: 8 Activity: Inaclive

Hidden state: Not hidden

A Create an & e of the logical disk
g Back up all the data this logical disk conlains.
; Restore the logical disk from an image
g Warning: This operation will delete all the data on this logical disk and replace them from the image you have
¥ chosen. You may also be asked to restart your computer during this operation.
‘i\;,;?

Copy the selected partition
Create a copy of the paitition. A new pastiion will be created and all the data wil be copied there.
‘You can create an exact copy, of copy only the area that is occupied by data.

When you select a small-sized bar (i.e. corresponding to a logical disk) the Explorer Bar will display information on it as
well. The page title will contain a drive letter, which is assigned to the disk. The disk layout graph will be colored in
accordance with the volume ratio of the used space to the free space (the light colored sector). The table on the right
will contain the following information:

e Volume label (if available),

e Type of the logical disk,
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e File system (represented by the color of the graph and the selected bar),
e Total size, used space and free space (in GB or MB).

Below there is a list of wizards, which may be called for this disk. All default values of parameters will correspond to the
disk settings.

Data Backup and Rescue

In this chapter you will find all the information necessary to establish a reliable data protection system.

Creating Backup Images

Depending on a type of information you need to protect and the way this information should be processed, the program
offers a number of handy backup wizards. To make your job with the program as easy and convenient as possible, all
backup wizards share similar work algorithm. By going through steps of the wizard, you configure all the necessary
settings to launch the backup operation. To minimize the possibility of making any mistake, the wizard provides auxiliary
information on every single option. Moreover you can get an in-depth description to any setting, control, or field of the
wizard just by clicking the hint button and then the object you need.

Simple Backup Wizard Startup
e In the Main Menu: select Wizards > Simple Backup

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Simple Backup Wizard Setup
The wizard offers the following steps to accomplish the backup operation:
e The object to back up. You can back up either an entire disk or separate partitions of the disk (primary,
extended or logical). In case of backing up an entire disk, you’ve got the possibility to include into the image

such disk elements as the Master Boot Record (MBR) and the first track of the hard disk. This can be very helpful
for serious disk recovery procedures.

Name Type Fio
3 My Computer My Compnter
il [7] Basic Hard Disk 0 (VMware, VMware Vitual S SCSI Disk Dev) Intemal Hard Disk Drive
- #55 First Hard Disk Track First Track
/ MeR i
€ Local Disk (C) Prmary N
(5] Basic Hard Disk 1 (VMware, VMware Vitual S SCSI Disk Dev) Intemal Hard Disk Drive
5% First Hard Disk Track First Track
(& Master Boot Record MER

¢ Name and location of the resulted image. Provide a file name for the new image and its exact location. The
program automatically offers an easy to understand name containing the date and the time of the archive
creation, which can anyway be modified.
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Select a folder wherne archive should be placed and speciy archive name. Archive name wil be used as a
subfolder where backup data files will be stored

Archive location: | Gi/ar_test/ e X X

e Siza | Date
=1 ] My Computer

i [E] Local Diske (C)

#- [5] Local Disk ()

- [E] Archives 153

5 :mapﬁ- {h200.0.1.1648'e) (Z))
1 EX) Metwork

Archive detais
Archive name are_tes)|
Estimated archive size: 2MB

Space avaiable on backup destination: 38 GB

The program automatically calculates size of the future archive and informs the user about
space available on the selected destination.

e Archive Comment. You can add some additional description to the archive that will later help to distinguish it
from the others.

Please enter a shod comment bo describe the archive

[
Mo comment

Result

After the backup operation is completed you receive an image of the selected object. This image is placed into the
specified destination, its features defined by the wizard.

Available operation scenarios:

e Backing up a hard disk or partition to a network drive

e Backing up a dual boot Mac to an external USB drive

Restoring System and Data

The program includes a convenient and reliable restore wizard. With its help you can restore all types of backup images
created with the program. It provides easy to understand instructions to configure and perform all the necessary
settings. Moreover you can get an in-depth description to any setting, control, or field of the wizard just by clicking the
hint button and then the object you need.

A This feature is only available for the bootable recovery environment.

Available operation scenarios:
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Restoring a dual boot Mac from an external USB drive

Restoring separate files and folders from a backup

Copy Tasks

In this chapter you will find all the information necessary to make a copy of a hard disk or a separate partition.

Cloning Hard Disks

You can clone a hard disk of any file system. During the hard disk copying process, the program moves controlling
records of used partitioning scheme, the bootstrap code and on-disk partitions. That’s why this operation cannot be

substituted by simply copying all on-disk partitions.

Copy Hard Disk Wizard

The Copy Hard Disk Wizard is a traditional-like wizard. By going through its steps, you configure all the necessary
settings to launch the copy operation. To minimize the possibility of making any mistake, the wizard provides auxiliary
information on every single option. Moreover you can get an in-depth description to any setting, control, or field of the

wizard just by clicking the hint button and then the object you need.

A You need at least two hard disks to carry out this operation.

Startup

In the Main Menu: select Wizards > Copy Hard Disk...

A

There are other ways to start up this function, please consult the Interface Overview

chapter to know more on the subject.

Setup

The wizard offers the following steps to accomplish the copy hard disk operation:

The hard disk to copy. Select a hard disk you want to copy.

On this page, you can choose a hard disk you would like to copy. All partitions from this hard disk will be copied
to the destination you will choose on the next page.

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)

l @) Local Disk (C:)

~oNTES

| Basic Hard Disk 1 (VMware, VMware “ﬂuﬁis SCS! Disk Dev)

B @) Local Disk (E7) l ©) LoclBasic Hard Disk 1 (VMware, VMware Virtual § SCSI D
Bl 34GBFATAZ 2AGENTFS 4G, || [WNZZGE

The target hard disk. Select a hard disk (if several) where all data of the source disk will be copied to.
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Select a target hard disk. Al data from the source hard disk will be copied there. During copy operation, target
disk content will be deleted

Basic Hard Disk 0 (VMware , VMware Virtual S SCS! Disk Dev)

l 9) ALocaI Disk {C) [Basnc Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)l

BNTFS

Copy parameters. The wizard enables to specify the following options:

Choose copy options that sut best your task
Copy options:
HDD raw copy

Parttions raw copy

Resize options:
Remove free blocks between parttions
V)| Copy data and resize parttions proportionaly |

7, Mark the checkbax to proportionaly change the size of panttions while keeping ther
K) ) relstive order intact
—” Tip: This can be very convenient when migrating o a larger hard disk

Copy options

- HDD raw copy to copy the hard disk in the sector-by-sector mode, thus ignoring its information structure (e.g.
unallocated space or unused sectors of existing partitions will be processed as well). This can help to avoid
problems with hidden data created by certain applications or the system administrator. However, it will take
more time to accomplish the operation.

- Partition raw copy to copy the on-disk partitions in the sector-by-sector mode to successfully process
unknown file systems. However it is not recommended to enable this option when working with supported file
systems as it takes more time to accomplish the operation.

Resize options

- Remove free blocks between partitions not to keep blocks of free space between partitions on the targeted
hard disk.

- Copy data and resize partitions proportionally to make the program proportionally change the size of
partitions keeping their relative order intact. The option can be useful when upgrading the hard disk to a larger
one.

Verification options

This section allows you to define whether the Surface and/or the Writing verification tests will be accomplished
during the operation.

After the operation is completed, you receive a fully functional duplicate of the existing hard disk.

Available operation scenarios:

Migrating system to a new HDD (up to 2.2TB in size)

Cloning Partitions

You can duplicate partitions to protect oneself from downtime in case of a system malfunction or for cloning sample

partitions. The program enables to duplicate all partition data including files, the exact structure of directories and file

system metadata (location of files, security information, access quotas, etc.).
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The Copy Partition Wizard will help you copy a partition of any file system. To minimize the possibility of making any
mistake, the wizard provides auxiliary information on every single option. Moreover you can get an in-depth description
to any setting, control, or field of the wizard just by clicking the hint button and then the object you need.

Startup

e |nthe Main Menu: select Wizards > Copy Partition...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Setup

The wizard offers the following steps to accomplish the copy partition operation:

e The partition to copy. Select a partition you want to copy.

On this page you can choose a volume to copy

Basic Hard Disk 0 (VMware, VMware Vitual S SCSI Disk Dey)
l ©) Local Disk (C:)
433 9GB NTFS

Basic Hard Disk 1 (VMware, VMware Virtusal S SCS1 Disk Dey)

m @) Local Disk (E) 'l © local Dis... Q) - I . ©) (Unallo
"8 34GBFAT2 {I 24GBNTFS | 14G.. 22GB

Destination disk. Select a hard disk with enough unallocated space to perform the operation.

The wizerd will create a copy of Local Disk (F:)from Basic Hard Disk 1 (VMware, VMware Virtual 5
SCS51 Disk Dev)

The copy will be created on Basic Hard Disk 3 (VMware, VMware Virual 5 SCS51 Disk Dev)
Plaasa sslect whene to create a copy:

Basic Hard Disk 3 (VMware, VMware Virual 5 SC51 Disk Dev)

I &) (Unallocated)
19.59GB

The program enables to copy a partition to a block of free space, which is smaller than the
partition itself, taking into account only actual amount of data.

o Copy parameters. The wizard enables to specify the following options:
Your hard disk after changes

Basic Hard Disk 3 (VMware, VMware Virduad 5 S5 Desk Deew)

G 4 GE
A gk

I @) (Unallocated)

Where to place a copy

Please speciy the size of the new partiion IE24  F9MB - 20473 MB
Please specy size of free space before the padition: [ t 0 ME - 20434 MB
Please speciy size of free space affterthe pardition: 16849 & 0 MB - 20,426 MB.
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- Partition size. Define the size (in Mb) of the copied partition.

- Free space before. Define the position (in Mb) of the copied partition relative to the beginning of the available
range of disk space.

- Free space after. Define the amount of trailing free space (in Mb) at the end of the available range of disk
space.

Partition size and position may also be defined by using the drag-and-drop technique. To do
that, just carry out the required operation on the Disk Map.

Result

After the operation is completed you receive a fully functional duplicate of the existing partition.

Boot Management

Our program enables to easily manage several operating systems on one computer with the help of the Boot Manager
Setup Wizard. Among the key features of the wizard the following should be mentioned:

e Up to 16 operating systems on one PC;
e Secure adding/removing of the Boot Manager startup record to/from the MBR;
e Auto Boot option to automatically start up the previously chosen OS after a certain time period;
e Hiding of any primary partition except selected at the moment.
Startup

e |nthe Main menu: select Tools > Setup Boot Manager...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Setup

The wizard offers the following steps to accomplish the operation:

e Boot menu options. In this section you can switch between the following modes:

- Normal mode. Choose this mode to display the boot menu every time the computer starts up and define a
timeout on the expiry of which the program will automatically select the previously chosen item of the menu.

- Hidden mode. Choose this mode not to display the boot menu until pressing a hot key. For this mode you
should define a hot key used to enable the Boot Manager and a time period in seconds the startup message will
be displayed.
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Boot menu options
@ Nommal mode
V| Timeout for booting last used configuration 15 seconds
Hidden mode
Time to display the BootManager stadup message

Choose a hot key for startup BootManager.

e Deactivating/Configuring the Boot Manager. These two options will only be available once the wizard has been
completed and launched again. Select the Deactivate option to remove the Boot Manager from the MBR
(Master Boot Record) or Configure to modify the previously set parameters of the startup process.

) Codwe

Choosa this option to antar Settings paga. You will be abla to configure BootManager appearancas and Boot

Menu cpbons
Deactivate

Choose this option to deactivate BootManager. This will remove BootManager and restors boot procass to s

previous state

Result

After the Boot Manager Setup Wizard is completed the program updates the original record in the MBR to get control of
the booting process and to be able to display the boot menu.

Available operation scenarios:

e Creating Dual Boot Systems

Partition Management

In this chapter you will find all the information necessary to carry out partitioning operations supported by the program.

Basic Partitioning Operations

Here you can learn how to accomplish basic partitioning operations (create, format, delete).

Creating Partitions

The program provides the ability to create a new partition within a block of un-partitioned space.
Restrictions
1. Do not use the Create Partition function in order to undelete the last deleted partition.

2. The program allows creating new partitions only within blocks of un-partitioned space. It cannot convert a free
space on an existing partition to a new partition.

3. The program cannot create new partitions on Dynamic Disks.
Express Create Partition Wizard Startup

e Inthe Main menu: select Wizards > Express Create Partition...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.
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Create Partition Wizard Startup

e |nthe Main menu: select Wizards > Create Partition...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Dialog Startup
1. Select a block of free space on the Disk Map;

2. Select in the Main Menu: Partition > Create Partition.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Express Create Partition Wizard Setup

Thanks to a highly intelligent work algorithm, the wizard requires minimal involvement in the operation, thus you only
need to choose a method you find the most suitable to create the partition (if several available), which actually differ in
the amount of space to allocate. For easy perception, you can see the resulted disk layout on the disk map by selecting

this or that mode.

The result you wil get sfter applying the changes

Basic Hard Disk 0 (VMware, VMware Virtual S SCS| Disk Dev)

I @) Local Disk (C:) I @) data {Z:) l @) New V

Please select the method of new partition creation
Smart Mode (Usa 182.1 GBto craate a partition ) More nfo
o | Advanced Mode | (Usa 108 5 GBto create a padition ) More nfo

The number of available methods depends on your disk layout.

A To learn more on the way the wizard works, please click the corresponding link on the first

page of the wizard.

Create Partition Wizard Setup

The wizard offers the following steps to accomplish the operation:

e Partition destination. Select a hard disk (if the computer has several hard disks) and then choose position for

the future partition on the disk: at the end (preferable), at the beginning or somewhere in the middle between

other partitions.

Copyright© 1994-2011 Paragon Software Group. All rights reserved.



47

O this page you can salect hard disk and the place where 1o create 8 new parttion
Basic Hard Disk 0 (VMware, YMware Vidual 5 SC51 Disk Dev) -
7] Local Disk {(C:) I ) data (£5)

Basic Hard Dizk 1 (VMware, VMware Virftual 5 5C51 Disk Dav)

I @) Local Disk (7]

-E

Basic GPT Hard Disk 2 {(VMware, VMware Virtual 5 SC51 Disk Dev)

I h. I Y_JJ {Unallocated)

Th.: pnr'lltll:n il be created "u:n:] F -

Lisa the butbons 1o move the madosr or drag mardoss by mouse. A new padition will b

the markeris

&
o
3
o
&
[

1

—

By default, the program allows you to create a new partition only as the last primary or as
Q the last logical drive within the extended partition. However, by activating the advance
mode on the first page of the wizard you can remove this restriction that in its turn might
result in some boot problems.

e Partition size. There is no restriction on size of the future partition, merely depending on space available on the
hard disk.

If there is not enough free space in one block, the wizard enables to redistribute free space, joining all free
space blocks together into one united block and moving partitions when necessary. If the total amount of free
space is still not enough, it is possible to split a fragment of space from one of the existing partitions, thus
resizing it.

Your hard disiz bafore the changes

|Basic GPT Hard Disk 2 (VMware, VMware Virtual 5 5CS| Disk Dev)

. I I @) (Unallocated)

r hard disk after the changes

Basic GPT Hard Disk 2 (WVMware, Viware Vidoal 5 5051 Disk Dev)

I I ) Local Disk (%)

If a partition to resize is locked and cannot be processed, the wizard makes the system
reboot to create the partition and then automatically boots the system again. (The
rebooting mechanism is different for different versions of Windows.)

=

You can also choose whether the future partition will be primary or logical by marking the appropriate
checkbox.

Copyright© 1994-2011 Paragon Software Group. All rights reserved.



48

e Partition properties. On the next page of the wizard you can set a number of additional parameters:

Your hard disk sfler the changes

Basic GPT Hard Disk 2 (VMware, VMware Virtual 5 5C51 Disk Dev)

I I ) New Volume (E)

Wolume |abeal: | New Volume

Aazsign the folowing drive letter- | E ':l
- Partition type. From the pull-down list select a file system the newly created partition will be formatted to,
otherwise the partition will remain unformatted (so that it will not be ready to use).

- Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually
used for drive identification.

- Surface test level. Define the level of the surface check to make the program find bad and unstable sectors and
mark them unusable in the file system metadata.
Dialog Setup

Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Yes
button to confirm the operation.

(-7 s
Are you sure you wanlt lo create a new parlition on disk 37
You are about to create a new parition in (Unallocated). 19.9 GB arca. Flease select size.
position and file sysiem of the new partition.
Basic Hard Disk 3 (WVMware, VMware Virtual 5 5C5] Disk Dev)
I 1) New Volume (H:) I
19.9GE NTFS
Create new parttion as: Primary parttion [
Flease spacify new partibon size 20479 - TMB-20473 MB
Please speciy size of free space befors the parition: 0 * OMB - 20,465 MB
Please specify size of free space afterthe patition: 0 % OMB-20472 ME
Please select file system for new partition: | NTFS EI
Flease anter new volume label: HNeaw Voluma
Flaasa spacify dive letter H EI
%) [More options l Yes ][ Mo I

o Define whether the partition will be Primary, Extended or Logical. You can choose the desired partition type
from the pull-down list. As a matter of fact, the available alternatives fundamentally depend on the selected
block of free space - within the Logical free space, only Logical partitions can be created; Within the Primary free
space, both Primary partitions or the Extended Partition can be created.

e Partition Size. Define the size (in Mb) of the new partition.

o Free space before. Define the position (in Mb) of the new partition relative to the beginning of the block of free
space.
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o Free space after. Define the amount of trailing free space (in Mb) at the end of the new partition.

Partition size and position may also be defined by using the drag-and-drop technique. To do
that, just carry out the required operation on the Disk Map. The virtual operations are to be
available.

o File system for new partition. From the pull-down list select a file system the newly created partition will be
formatted to, otherwise the partition will remain unformatted (so that it will not be ready to use).

o Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually
used for drive identification.

e Drive letter assignment. The pull-down list contains vacant drive letters that can be associated with the newly
formatted partition.
In addition, there is the possibility to make further detailed settings (although the default values will do in most cases).
To activate the advance mode, you need to click the More options button at the foot of the dialog page. Depending on
the chosen file system, the following options become available:

| Use D5 buk in fomat routine
Flaase selact numbar of sectors per cluster: | 8 [=]
Please select number of sectors per boot

Plaase salact number of root entres
\Rﬂm defaults
e Use OS built-in routine. Mark the option to restrict the available values according to the used OS.

o  Whether the surface test will be performed. Define the level of the surface check to make the program find bad
and unstable sectors and mark them unusable in the file system metadata.

e The amount of sectors per boot. This parameter is available exclusively for FAT16 and FAT32 file systems. Set
the number of sectors to be reserved for the boot area on the partition with this spinner control.

e The amount of root entries. This parameter is available exclusively for FAT16 file system. Set the maximum
amount of files/directories to be placed in the Root Directory on the FAT16 partition.

o The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this spinner control.

.A Number of available options depends on the selected file system type.

Result
After the operation is completed you receive a fully functional partition.
Available operation scenarios:

e Creating a new partition to detach operating system from the rest of data
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Formatting Partitions
Any partition should contain some file system to be used for keeping data. The process of installing a file system is
commonly known as formatting. A huge variety of file systems have been developed these days.
Supported File Systems
The program provides the ability to format partitions of the following file systems:

- FAT12 & FAT16

- FAT32

- HFS+

- NTFS

- Ext2

- Ext3

- Ext4

- Linux Swap v. 2
Wizard Startup

e |n the Main menu: select Wizards > Format Partition...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Dialog Startup
1. Select a partition on the Disk Map;

2. Select in the Main Menu: Partition > Format Partition.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Wizard Setup

The wizard offers the following steps to accomplish the operation:

e Partition to format. Select a hard disk (if the computer has several hard disks) and then the required partition to
format.
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On this page, you can choose a volume you would like to format

Basic Hard Disk 0 (VMware, VMware Virtual S SCS1 Disk Dey)
‘I @) Local Disk (C:) ‘ l ©) data (Z))
L 2829 GB NTFS | M 217GBNTFS

Basic Hard Disk 1 (VMware, VMware Virtual S SCSI Disk Devy)

l ©) Local Disk (*)
43393 GB NTFS

Basic GPT Hard Disk 2 (VMware, VMware Virtual S SCSI Disk Dev)

I I @) (Unallocated)

.A As a result of this operation contents of the selected partition will be lost.

e Partition properties. On the next page of the wizard you can set the following partition parameters:
Yowr hard disk after the changas
Basic Hard Disk 0 (WVMware, VMware Vidoual 5 SCS1 Disk Dev)

I ©) Local Disk (C:) l 4 data (Z7)

Volume label: | Mew Volume
- Partition type. From the pull-down list select the desired file system type. In fact, the program displays only
those file systems that can correctly be placed to the selected partition, taking its capacity into account.

- Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually
used for drive identification.

- Drive letter assignment. The pull-down list contains vacant drive letters that can be associated with the newly
formatted partition.

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases).
To activate the advance mode, you need to mark the appropriate option at the foot of the page. When it is marked, the
next page enables to define:

7][Use OF buil in format routine |

Please salact sectors par cluster

2 [+
e Use OS built-in routine. Mark the checkbox to restrict the available values according to the used OS.

e  Whether the surface test will be performed. Define the level of the surface check to make the program find bad
and unstable sectors and mark them unusable in the file system metadata.

e The amount of sectors per boot. This parameter is available exclusively for FAT16 and FAT32 file systems. Set
the number of sectors to be reserved for the boot area on the partition with this spinner control.
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e The amount of root entries. This parameter is available exclusively for FAT16 file system. Set the maximum
amount of files/directories to be placed in the Root Directory on the FAT16 partition.

e The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this spinner control.

A Number of available options depends on the selected file system type.
?)

Dialog Setup

Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Format
button to confirm the operation.

Bl <=
= 4’ Are you sure you want to format volume (F:)?

You are about 1o format volume (F:) [No label]. NTFS. Your computer may
no Jonger boot or work comectly

Please select new fle system:  [ZNACHNNN ~

Please enter new volume label: | New Volume

¥) More options l Fomat | | No

e File system. From the pull-down list select the desired file system type. In fact, the program displays only those
file systems that can correctly be placed to the selected partition, taking its capacity into account.

o Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually
used for drive identification.

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases).
To activate the advance mode, you need to click the More options button at the foot of the dialog page. Depending on
the chosen file system, the following options become available:

o Use 05 built in format routine

Please select rumber of sectors percluster: | 128 [+

Pleasa salect number of sectors per boot:

Fleass sslect number of oot entries:

Restore defauls |

e Use OS built-in routine. Mark the checkbox to restrict the available values according to the used OS.

o  Whether the surface test will be performed. Define the level of the surface check to make the program find bad
and unstable sectors and mark them unusable in the file system metadata.

e The amount of sectors per boot. This parameter is available exclusively for FAT16 and FAT32 file systems. Set
the number of sectors to be reserved for the boot area on the partition with this spinner control.

o The amount of root entries. This parameter is available exclusively for FAT16 file system. Set the maximum
amount of files/directories to be placed in the Root Directory on the FAT16 partition.
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o The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this spinner control.

A Number of available options depends on the selected file system type.
?

Result

After the operation is completed you receive a fully functional partition formatted to the specified file system.
Deleting Partitions
Wizard Startup

e |nthe Main menu: select Wizards > Delete Partition...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Dialog Startup
In order to start the operation you should take the following steps:

Launcher
1. Select a partition on the Disk Map;

2. Select in the Main Menu: Partition > Delete Partition.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Wizard Setup

The wizard offers the following steps to accomplish the operation:

e Partition to delete. Select a hard disk (if the computer has several hard disks) and then the required partition to
delete.
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On this page. you can choose 3 volume you would ke to delete
Basic Hard Disk 0 (VMware, VMware Virtual S SCS1 Disk Dey)

.wl.ocd[lal((c:) I(_)Jdda(Z:)
2823 GB NTFS 217 GB NTFS

Basic Hard Disk 1 (VMware, VMware Virtual S SCS| Disk Dev)

I ©) Local Disk (7) .
4933 GBNTFS

Basic GPT Hard Disk 2 (VMware, VMware Virtual S SCS1 Disk Dev)

l l ©) (Unallocated)
5698 GB

‘ / ! "'\ You are about 1o destroy a bootable partition!

. A As a result of this operation contents of the selected partition will be lost.

o Merge free blocks. As a result of the operation you may get several blocks of the unallocated space on the hard
disk. So choose whether to merge them all and place at the beginning of the disk or at the end by selecting the
required operation from the pull-down list.

Merpe fres blocks options
Do mot maps fres blocks s |:|

Marge frea blocks at tre and 5 the disk

. Do ot merge free blocks
Merge free blocks at the beginning of the disk

Dialog Setup

Initially the program suggests you just to remove references to the selected partition from the Partition Table.

=<

P

4‘? Are you sure you want to delete volume (F:)?

w You are about to delete volume (F:) [No label], NTFS. Your computer may
no longer boot or work comectly.

¥)[Do not ask volume tabel next time |

o Enter the volume label to confirm deleting. To confirm deletion of the selected partition, enter its Volume
Label. The current volume label is displayed above.

e Do not ask volume label next time. Mark the option to inhibit confirmation next time you start the dialog.

Result

By default, the operation takes only a fraction of a second. However, the program waits until Windows completes the
modification of the disk layout.
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Advanced Partitioning Operations

Here you can learn how to accomplish advanced partitioning operations.
Merging Partitions

The Merge Partitions Wizard enables to consolidate the disk space, which originally belongs to two adjacent partitions,
into a single, larger partition. The order, in which two partitions have been chosen, is important since all contents of the
second selected partition will be placed in a folder on the resulted joined partition.

The program provides the ability to merge only NTFS, FAT16 or FAT32 partitions.

Startup

e Inthe Main menu: select Wizards > Merge Partitions...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Setup

The wizard offers the following steps to accomplish the operation:

e The partition to expand. Select a partition, the size of which you need to increase by up-taking contents of an
adjacent partition.

On this page. you can choose 3 patition that will be expanded to include adiacent parition, Please note that R is
passble to select only FAT, FAT32 or NTFS paritions. You will not be able to proceed futher # no adacent
parttions of these types are present on the disk

Basic Hard Disk 0 (VMware, VMware Virtual S SCS1 Disk Devy)

@) Local Disk (C)) . @) data (Z)
M 222 9GB NTFS 217GB NTFS

e The partition to merge with. Choose the second partition for the merge operation, the contents of which will be
placed in a folder on the resulted joined partition. By default, the program offers an easy-to-understand folder
name to store files of the second partition, which however can be customized.

Selact an agacent pantition 1o merge with the target patition. This parttion wil be mergad to the one you have
selectad on the previous page. The content of the second parttion will be placed in & folder inside the resulting

partbon

Basic Hard Disk 0 (VMware, VMware Vituad S SCS1 Disk Dev)

l @) Local Disk (C) | ©) data (Z))

3B NTFS 217GB NTFS

Specfy a folder name 10 keep content of the selectad parttion

Foidar Name |merged_parttion_conrtent
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Be particularly careful when selecting system partitions to process, since the incorrect
order, in which two partitions have been chosen, will result in inability to boot the
operating system.

Result

After the operation is completed the disk space of the two adjacent partitions will be consolidated.
Redistributing Unused Space between Partitions

Express Resize Partitions Wizard

The Express Resize Partitions Wizard enables to easily increase free space on one partition by up-taking the unused
space of an adjacent partition of your hard disk.

Startup

e In the Main menu: select Wizards > Express Resize Partitions...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Setup

The wizard offers the following steps to accomplish the operation:

e Adjacent partitions to resize. Click on the left partition of the pair of partitions you need to redistribute the
unused space between, as the right one will be selected automatically.

The wizard wil resze space between Local Disk (C:) and data (Z:) on Basic Hard Disk 0
(VMware, VMware Virtual S SCSI Disk Dev)

Select left patttion from a pair of adacent partitions you would ike to resize. Right adjacent parttion will be
selected automaticaly

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dey)

ll ©) Local Disk (C?) I ©) data (Z)
2829 GB NTFS

NTEC

e Resulted size of partitions. Redistribute the unused space between the partitions with the slider or manually by
entering the required value.

Please specfy new sizes of selected pantions

Selected pant of Basic Hard Disk 0 (VMware, VMware Vitual S SCS| Disk Dev)

l ©) Local Disk (C:) . @) data (Z)

n ‘
Left volume size Right volume size

28977¢MB % MB | 222221M8 % MB
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Result

After the operation is completed the unused space between the specified partitions will be redistributed according to
your needs.

Available operation scenarios:

e Increasing size of a system partition by taking unused space of an adjacent logical partition

e Resizing partitions of Apple Boot Camp

Redistribute Free Space Wizard

The Redistribute Free Space Wizard helps to increase free space on one partition by up-taking the on-disk unallocated
space and the unused space of other partitions. By default, the wizard adds to the target partition all existing blocks of
the free space. Besides you can specify partitions to act as a space donor. The wizard will automatically recalculate
positions of the partitions and move their contents to new locations.

Startup

e Inthe Main menu: select Wizards > Redistribute Free Space...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Setup

The wizard offers the following steps to accomplish the operation:

e Partition to enlarge. Select a partition, the size of which will be increased at the expense of other partitions.
Blocks of the free space (if any) will be automatically added to the target partition.

Choosa 3 volume to expand
Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dey)

’I @) Local Disk (C:) " I(_a/daa(Z:)

2829 GB NTFS 217GB NTFS

1) Capasty of the volume (C:)is 282.9 GB. The wizard can expand this volume up 10 485.3 GB at the
expance of other volumas
Howe wil the wizar

g &xpand the yo «-eT

e Partition to donate. Choose any partition(s) (not only adjacent) to donate free space.
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umes to take space from. Free space from that volume will be used to enfarge the volume you have

the previous page

Volume Fle system | Type | Capacty | Used space | Fee space | U Free
| Z NTFS Pimay 217GB 146GB  2023GB ,-]
L) There is no unaliocated space on the hard disk you have selected. The wizard can only expand the

volume (C:) at the expence of some other volumes. Please

~
free space from &t

¢ the chack box net to any volume {0 take

e Partition size. By default, the program leaves 50% of the unused space on a partition and removes another 50%
to add it to the target partition. However, the size to take can be customized by moving the slider or by
manually entering the exact value.

Your disk: after the changes
Basic Hard Disk 0 (VMware, VMware Vifual 5 5C51 Disk Devw)

I @) Local Disk (C:) I ) data (7]

2GR NTF

Selact new size:
353.371.86 '-'E:i 289,776 MB - 456,975.28 MB

b)) Curent volume size: 384 1 GB
The volume size has been increased on 101.1 GB.

Result

After the operation is completed free space of the specified partition will be increased by up-taking the on-disk
unallocated space and the unused space of other partitions.

Undeleting Partitions

When simply deleting a partition (without additional wiping) disk management software only removes references to it in
the Partition Table, thus leaving the possibility to recover it later.

The program enables to find and recover these partitions. A restored partition will be fully functional, as long as other
partitions were not created, moved or exceeded the disk space occupied by that partition. That is why the program
offers this function only for blocks of free space.

The operation can be accomplished with the Undelete Partition Wizard.

Startup

e |n the Main Menu: select Wizards > Undelete Partitions...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Setup

The wizard offers the following steps to accomplish the undelete partition operation:
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o Free blocks to scan for lost partitions. Choose a free block from a tree-like list of available hard disks.

Chick: the check box next to any hard disk dive or frese block you want (o eommine

Name Type
= Ell My Computer My Computer
= [¥] [E] Basic Hard Disk 3 (VMware, Viware Vitual S SCSI Disk Dev) Intemal Hard D8

EllSunsocmed [

The summary =z of fragment (3) to analyze is 19.9GB

e Search method. By default, the wizard selects the fastest search method for your operating system. In most
cases that will do to find any accidentally deleted partition. However if you're under Windows XP for instance
(the Conventional Search option is selected), but the deleted partition you're looking for has been created with
the Disk Management utility under Vista, the wizard won't be able to find this partition, unless you manually
select the appropriate option (Quick Search for Partitions Created by Vista or Later OS). Moreover if the wizard
still fails to find the partition you need, you can select the Thorough Search option to scan every single sector in
the specified search area to get the most accurate results.

Choose how to look for the deleted partitions:
| Quick search for partitions. created by Vista or later OS |
@ Conventional search
Thorough search
¥ Show file systems search options

To know more on the available search methods, please use the context sensitive hint
system.

o File system filter. By default, the wizard will search for all known file systems. However, by clicking on the
appropriate option on the second page of the wizard, you can specify only those file systems you need.

2 Hide file systems search options
| Al known file systems |
FAT and FAT32 fie systems
V| NTFS file system
Uinux B42 and B3 file systems
05/2 HPFS file system
Other funkisted) file system
To begin search, cick Next

e A partition to undelete (if several). By default, the program searches records of any deleted partition ever
existed on the selected block of free space. So you can get several partitions to choose from.
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E; Search debsted parttions from sector: 40 1o sector 27HHF

The following paritions have been found:

Fils mystem Type Capacity Used Space [ % Used
TNTFS Primany 199GEB 853 MB 0
[ Stop seanch ]

Most likely the required partition will be found first. If so, you may abort the search operation by pressing the
Stop search button.

Result

After the operation is completed you receive a fully functional partition.

Installing a New Operating System

Getting your computer ready to install a new operating system, especially when it is going to be an additional OS in the
system, is a rather complicated task that implies quite a number of operations, from allocating space to create a new
partition (resize, redistribution of free space) to formatting of the newly created partition to a particular file system and
checking its surface for bad sectors to avoid possible data loss. Operating systems today are being supplied with basic
tools of partitioning that only enable to create a partition (in case there is enough unallocated space on the disk) and
then format it to the specified file system type. Our program offers a handy Install New OS Wizard to easily carry out all
the necessary operations to install a new operating system.

Startup

e Inthe Main menu: select Wizards > Install New OS...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Setup

The wizard offers the following steps to accomplish the operation:

e Partition to install a new operating system. The program offers two ways of installing a new OS, i.e. to create a
new primary partition for it or use an existing one.
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Wheie would you ke to nstall an operating system?
(&) | want to create 3 new pimary partition to install 05

A new partiton will be created by using unallocated space of your hard disk or unused space of ewsting
pastitions. It iz the most preferable way as no system of user’'s data will be affected during the instalabon
process.

(O | want to use an existing pemary partiion to instal 0S.
In case creahon of a new primary partiion iz not possible (there are already four primary partitions on the
disk) of not desirable, you are free to select any of existing prmary partitions. Please note that al data on

the selected partition will be deleted f you choose to format it latet in this wizard Besides make sure no
operating system has already been mstalled on that partibon.

.A Only primary partitions can be used to install an operating system.

- In case the first option has been marked, the wizard enables to specify:

A hard disk (if several) where a new partition will be created. Thanks to an advanced program engine it is
possible to use unallocated space of the disk (if any) and unused space of existing partitions to create a new
partition;

O thas page wou can choose a hard disk [ several] whene pou would e to create a new primany partition

E-Ilati: Hard Dizk 0 [Maxtor 250000

Ren l L.
l 1933 GBINTFS % 37

. Tobsl size: 1939 GB

+ 71
Basic Hard Dizk 1 [STI160815A5) ,';T:: 1? ]62?“3:8
lw.. @) (0] It:_}J[E:I
19 £34GB NTFS BEGEMTFS

Q To avoid any possible problems, the new partition will in no way be created as the first
partition of the disk which already contains at least one partition.

And its size. If there are blocks of the free space on the disk, the wizard will merge them all and allocate the
resulted space for a new partition in the first place. If not, it will take 50% of the unused space of an adjacent
partition. However, the size to take can be customized by moving the slider.

W'ou can select esther a block of unallocated space from the disk or an sasting parbiion fos whach the wused
space will be used 1o create & new partition

Basic Hard Digk 0 [Maxtor A 250P0)

l@ﬂ Iww
1821 GB NTFS 51.6GE Mot

New wolume - cument size iz 51.6 GB
Mir Vohume Size: 0 Bytes Max Volne Se: 1565 GE

- In case the second option has been marked, the wizard enables to choose an existing primary partition to

install a new operating system.
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On this page you can choose an exitting primary partition where you would like o install 3 new opetating system
Basic Hard Disk 0 (Maxtor 7Y250P0)
O | B8
163.3 GB NTFS N l 37.GE
Total size: 163.3 GB

Basic Hard Disk 1 (ST3160815AS)  [Used: 77.2GB
Free: 86.1 GB

I Q) - . w (D:) I w) (E3)
LA 634 GB NTFS 66 GB NTFS

A Your computer may fail if any other OS has already been installed on the selected partition.
?)

Result

Partition properties.
[+] “rez, | want to format the pastition
Partition typec | BPNTFS w

Aszsign the following dive letter: [
Suace testlavel | Mone %

- Partition type. From the pull-down list select the desired file system type. In fact, the program displays only file
systems that can be correctly placed to the selected partition, taking its capacity into account.

- Drive letter assignment. The pull-down list contains vacant drive letters that can be associated with the newly
formatted partition.

- Surface test level. Define the level of the surface check to make the program find bad and unstable sectors and
mark them unusable in the file system metadata.

OS Label. Enter a label for the selected partition in the textual field. It will later be used for the drive
identification.

05 labels vall be dizplaved in the Boot Manages’s slaitup merm bo help you boot the requied operating
syshem,

05 labet [Windows 7

As the final step the wizard will offer you to insert a distributive CD/DVD of the new operating system and restart the

computer to launch the installation procedure.

The program will update your MBR, so most likely you won’t be able to start up any of the
previously installed operating systems. Please launch the Boot Manager Setup Wizard after
the installation has been completed to fix this issue.

Available operation scenarios:

Creating Dual Boot Systems
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Moving/Resizing Partition

The Move/Resize Partition function allows you to resize or change location of any partition without destroying its data.

In order to move/resize a partition you should take the following steps:

1. Select a partition on the Disk Map.

2. Select in the Main menu: Partition > Move/Resize Partition...

A

There are other ways to start up this function, please consult the Interface Overview

chapter to know more on the subject.

3. Define parameters of the operation.

&

6 Are you sure you want to move/resize system volume (C:)?
¥ You are about to move/resize NTFS volume [No label], (C:)

Basic Hard Disk 0 (VMware, VMware Vitual S SCSI Disk Dey)

l ©) Local Disk (C:)

2823 GBNTFS

Volume size 283776 MB  +[e] 11.923MB - 283721 MB

Frea space befora. 0.7 MB $lw| Obytes -277.850.73 MB

Volume size. Define size (in Mb) of the modified partition.

Free space before. Define the partition position (in Mb) relative to the beginning of the available range of
disk space.

Free space after. Define the amount of trailing free space (in Mb) at the end of the available range of disk
space.

Sector to sector move. Mark the checkbox to move the partition in the sector-by-sector mode to process its
unused space as well. This can help to avoid problems with hidden data created by certain applications or
the system administrator. However, it will take more time to accomplish the operation.

WA

Partition size and position may also be defined by using the drag-and-drop technique. To do
that, just carry out the required operation on the Disk Map. The virtual operations are to be
available.

When resizing a FAT16 partition beyond the 2GB limit (maximum file system size), the
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partition will automatically be converted to FAT32.

The program enables to enlarge NTFS partitions (system, locked) without rebooting
Windows and interrupting its work, providing 100 percent guarantee that your data is kept
intact.

4. The operation will be performed immediately after confirmation.

Available operation scenarios:

e Increasing size of a system partition by taking unused space from any other

e Shrinking a system partition to increase size of a data partition

Converting File System

With our program you can change type of the used file system without destroying its data. While performing the
operation, it first checks the current file system for consistency and then verifies whether the on-partition data meet the
requirements of the desired file system or not. After having passed the testing, the program re-organizes the file system
metadata and user files.

The program enables to convert the following file system types:
- FAT16 > NTFS, FAT32

- FAT32 > NTFS, FAT16

- NTFS > FAT16, FAT32

- Ext2 > Ext3

In order to convert a file system you should take the following steps:
1. Select a partition on the Disk Map.

2. Select in the Main menu: Partition > Convert file system...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

3. Initially the program suggests some consistent values for all parameters. In most cases, you can just press the
Convert button to confirm the operation.

o e
{'Q%\ Are you sure you want to convert system volume (C:)?

b)

1 You are about 1o convert fle system on volume (C:) [No label), NTFS

Your computer may No 1onger DOOt O WOk Comactly

Please select new file system

Select new cluster size
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o New file system. From the pull-down list choose a file system you would like to convert to. Actually the

program only displays variants available for the operation, taking into account the current parameters of the
selected partition and limitations of the used file system.

e New cluster size. Define the cluster size for the partition. This parameter can have a profound effect on the
overall performance. In a nutshell, larger clusters waste more space, but generally provide for slightly better
performance, because of less fragmentation. So be particularly careful with it.

The cluster size value is expressed in sectors per cluster. To get it in Kbytes, please divide it
A into half.

You may only decrease the current cluster size.

e Surface test level. Define the level of the surface check to make the program find bad and unstable sectors
and mark them unusable in the file system metadata.

4. The operation will be performed immediately after confirmation.

Making Logical/Primary

The program allows you to include a primary partition in the extended partition, or exclude a logical partition from the
extended partition, without partition duplication.

In order to change a partition type you should take the following steps:
1. Select a primary or logical partition on the Disk Map.

2. Select in the Main menu: Partition > Modify > Make Partition Logical/Primary.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

c@\ Are you sure you want to make the partition logical?
1 You are about 10 make the paation (C:) [No label). NTFS logca

Yes } No

The Make Primary > Logical option is only available when the selected partition is adjacent

Q to the extended partition and vice versa.
The Make Primary > Logical option of the system partition will result in inability to boot the
operating system.

3. The operation will be performed immediately after confirmation.
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Changing Partition Attributes

This chapter explains how you can change partition attributes (Active flag, Hidden flag, Volume Label, etc.).

Mark Partition Active/Inactive

The program enables to set an active/inactive flag for primary partitions of a hard disk. By default, an operating system
will boot only if its partition is active or bootable.

In order to mark a partition active/inactive you should take the following steps:
1. Select a primary partition on the Disk Map.

2. Select in the Main Menu: Partition > Mark Partition as Active/Inactive.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

EE =
Are you sure you want to set the volume as active?

You are about to set the volume (F:) [No label]. NTFS as active. ¥ you already
have active volumes, this action might render your system unbootable

!

—

Yes j No

3. The operation will be performed immediately after confirmation.

There can only be one active partition on a hard disk, otherwise your operating system will
fail to boot.

Hide/Unhide Partition

The program allows you to hide/unhide primary and logical partitions. By default, an operating system does not mount
hidden partitions, thus preventing access to their contents.

In order to hide/unhide a partition you should take the following steps:
1. Select a partition on the Disk Map.

2. Select in the Main Menu: Partition > Hide/Unhide Partition.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

3. The operation will be performed immediately after confirmation.

It is strongly recommended not to hide the system partition. Otherwise your operating
system will fail to boot.
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Set Label of a Partition

The Partition Label is a small textual field (up to 11 characters) that is located in the partition's boot sector. It is
detectable by any partitioning tool and is used for notification purposes only.

In order to change a partition label you should take the following steps:
1. Select a partition on the Disk Map.

2. Select in the Main Menu: Partition > Modify > Change Volume Label.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

3. Enter a label for the selected partition.

s
Are you sure you want to change label on volume (F:)?
! Please specy 3 volume label for easier recognition of your volume

Please enter new volume label:  New Volume

] [

4. The operation will be performed immediately after confirmation.

Hard Disk Management

In this chapter you will find all the information necessary to carry hard disk operations supported by the program.

Updating MBR

The program enables to overwrite the current bootable code in the MBR (Master Boot Record) by the standard
bootstrap code. This can help to repair a corrupted bootable code of a hard disk resulted from a boot virus attack or a
malfunction of boot management software.

In order to update MBR of a hard disk you should take the following steps:
1. Select a hard disk on the Disk Map.
2. Select in the Main Menu: Hard Disk > Update MBR.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

1 Are you sure you want to update master boot record?
— Cumrent MBR contents for hard disk number 0 will be lost after this operation. Your

computer may no longer boot comectly
I Yes i | No

3. The operation will be performed immediately after confirmation.
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Extra Functionality

This chapter describes the supplementary functionality available in the program.

View Partition/Hard Disk Properties

The program enables to obtain in-depth information on the properties of hard disks and partitions. Besides the general
information, such as capacity, used space or file system type it provides the possibility to get info on hard disk geometry,
cluster size, exact partition location, etc.

To get properties on a partition/hard disk, please do the following:
1. Choose a partition/hard disk on the Disk Map.
2. Select in the Main Menu: Partition/Hard Disk > Properties...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

-2 e
General| | File System Info ]Admced

Local Disk (C:)

Volume label: [No label]
File system: NTFS
Type: Prmary
Capacity: 4393GB
536.868,814.848 Bytes
1.048.571.904 Sectors
Used by data: $3GB(1%)
10,016,497 664 Bytes
19,563,472 Sectors
Free space: 4306GB (33%)
526.852.317,184 Bytes
1.029.008,432 Sectors

In the opened dialog information will be grouped according to its properties, thus by clicking tabs you can get
information you need.

Volume Explorer

Volume Explorer is a special tool to browse and export contents of the local mounted/unmounted volumes formatted to
FAT16, FAT32, NTFS, Ext2FS, Ext3FS, Ext4FS file systems. Besides it enables to access Paragon backups as regular folders
to explorer their contents or to retrieve certain files.

To launch the Volume Explorer you should click Disk View tab in the Explorer Bar and then choose Volume Explorer:
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| Disk View | Scheduled Tasks | Archives | Help |

Mame Size Modified
& G CO/OVD Drives
el = Cf) Hard Disks
& [E] 1. VMware, VMwars Vitual 5 SCSI Disk Devi 500G
= [E] 2 VMware. Viware Virdual § SC51 Desk Devi 10GE
@ . Prmaey FAT22 [E) 14GB
& @2 Primary NTFS (F) 24GB
* m Q22009 4:19:34 AM
=L 9/2/2009 £:24:45 AM
5 @3 P 14GB
& 4. Pimary Linuze Swap 509.8 MB
& [Z] 3. VMware, VMware Vidual 5 S5 Disk Devi 80GB

£ 4 [E] 4. VMware_ Viware Vitual S SCS51 Disk Devi (GPT Disk)
B & O] virual Doives

Call the popup menu for the selected file/folder (right click of the mouse button) to export it to some other location
(local or network drive, etc.).

% Select a destination folder for the export operation ﬁ1
lookin: | Fllocaleskc) [+] & % 2

[ ) [ Gows

Available operation scenarios:

e Restoring separate files and folders from a backup

Mount Partition

The program enables to assign or remove drive letters of existing formatted partitions.

Assign Drive Letter
In order to mount a partition you should take the following steps:
1. Select a partition on the Disk Map.

2. Select in the Main Menu: Partition > Assign Drive Letter...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.
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3. Specify a drive letter for the selected partition. Initially the program suggests some consistent value for this
parameter. So you may just press the Yes button to confirm the operation.

o e

"\\ Assign a drive letter?
N

1 This allows access to the volume by using the drive letter assigned. The
assignment is not recommended £ the volume contains a file system not
supported by your operating system

Assign the folowing drve letter __;J

However you can manually define the required letter by selecting it from the pull-down list of available drive
letters.

4. The operation will be performed immediately after confirmation.

Remove Drive Letter
In order to un-mount a partition you should take the following steps:
1. Select a partition on the Disk Map.

2. Select in the Main Menu: Partition > Remove Drive Letter.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

3. The operation will be performed immediately after confirmation.

Modifying drive letter of the system partition will result in inability to boot the operating

f system.
After having processed partitions with installed software, some programs may not run
properly.

Defragment Partition

Defragmentation is the process of rewriting parts of a file to contiguous sectors on a hard disk to increase the speed of
access and retrieval. When files are updated, the computer tends to save these updates on the largest continuous space
on the hard disk, which is often on a different sector than the other parts of the file. When files are thus fragmented,
the computer must search the hard disk each time the file is opened to find all of the file's parts, which slows down
response time.

The program provides the necessary tool for the defragmentation of NTFS and FAT partitions.

In order to start the operation you should take the following steps:
1. Select a partition on the Disk Map.

2. Select in the Main menu: Partition > Defragment > Defragment Partition...
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There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

3. Initially the program suggests some consistent values for all parameters. In most cases, you can just press the
Yes button to confirm the operation.

o |

Defragment wolume (C:)7

Defragmentation may improve peformance of your system. For locked
volumes, howenver, this operation will require the system restart.

Directories placement
Put drectones: Leava asis [ ]
Sort options
Sort bry size Do mot soet 3
Sort by modfication time: | Do not soet -]

¥) More cptions Yes [ ]

e Directories Placement. From the pull-down list select the way how to sort directories.
e Sort by size. Sort files according to their size.
e Sort by time. Sort files according to the last time of update.

In addition, there is the possibility to make further detailed settings (although the default values will do in most
cases). To activate the advance mode, you need to click the More options button at the foot of the dialog page:

System files options
V| Do not save content of pagefile sys and (or) hiberfil sys

Pagefile sys and Hbedile sys are OS temporary files and are only usad for
the curent Windows session. Thus excluding them from processing will
reduce time required to accomplish the operation

Defragmentation options
0 Safe mode fecommended)

The operation may require a kot of time to complete, but it guarantees
consistency of your data. Pleasa use this mode when your computer is not
going to be in operation for a considerable penod of time

Fast mode

The operation will go much faster, but there's a chancea of loosing data
because of a power outage. Please make a backup of your data before
using this mode

e Skip auxiliary files. Mark the option to ignore contents of the PAGEFILE.SYS and HIBERFIL.SYS system files.
These files are used temporarily in the operating system.

o Defragmentation Mode. Select the preferable defragmentation mode.
4. The operation will be performed immediately after confirmation.

Available operation scenarios:

e Hard Disk Optimization
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Test Surface

The program enables to test surface of existing partitions and blocks of free space for bad or unstable sectors. If found
any it automatically marks them unusable in the file system metadata, thus minimizing the risk of data loss.

In order to start the surface test you should take the following steps:
1. Select a partition or a block of free space on the Disk Map.

2. Select in the Main Menu: Partition > Test Surface...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

3. From the pull-down list choose the level of the surface check.
PR =<
@ Test surface of volume (C:)?
Testing volume surface allows 1o find bad blocks and other problems
Please select a suface test level [IE-E
| Yes ‘ No

4. The operation will be performed immediately after confirmation.

Check File System Integrity

The program allows you to check integrity of a file system. It can be used to detect possible file system errors before
performing any operation on a partition.

To start the system integrity check you should take the following steps:
1. Select a partition on the Disk Map.

2. Select in the Main Menu: Partition > Check File System Integrity

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

B <
.1@\ Check volume (C:) [No label]. NTFS for errors?

1 Please note that check operation needs exclusive access to the volume. You may be
asked to restart your computer to complete the operation

3. The operation will be performed immediately after confirmation.
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Edit/View Sectors

With the built-in Edit/View Sectors tool the program enables to view/edit sectors on existing partitions/hard disks
providing the possibility to directly access and modify sectors, save and restore sectors from specified files, navigate
through the system metadata, etc.

In order to edit/view sectors of a hard disk/partition you should take the following steps:
1. Select a hard disk/partition on the Disk Map.
2. Select in the Main Menu: Partition/Hard Disk > Edit/View Sectors.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

&R =
Edit sexciors on Basic Hard Diske 0 (VMware, VMwan: Virtual 5 5051 Disk Dev)
Cuerent sectoris Dof 1,048,575.999.

Please select sector number 0 ' BEEPE O-§¢ HE @@

0x0000000000 33 20 8= 40 be 00 7o 8= c0 8= 483 be 00 e bE 0O 3hoPh. | LA BN | L. ‘]

Ox00000000L0 06 b9 0D 02 fc £3 a4 50 63 1c D6 cb fb b9 04 00 Y ugEPh. EGY .
0x0000000020 bd be 07 80 7e 00 00 7c Ob Of 85 Oe 01 83 5 10 a0~ A

0x0000000030 &2 £1 ed 18 88 56 00 55 cé 46 11 05 <& 46 10 00 &%l V. UEF. EF. .
0x0000000040 b4 41 bb aa 55 cd 13 5d 72 0f 81 fb 55 aa 75 09 “hod UL ] Al
Ox0000000050  £7 <1 01 00 74 03 fe 46 10 66 &0 80 7e 10 OO 74 At .BPF.ET .~ .t
0x0000000060 26 66 &8 00 00 00 00 && £f 76 08 &8 00 00 &8 00 &th fyv.h..h

0x0000000070 Pe &8 01 00 &8 10 0D b4 42 8a 56 00 8b £4 od 13 |b. k. "B.V..A&L
Ox0000000080  9f 83 c4 10 9= eb 14 b8 01 02 bb 00 7c 3a 56 00 k& ow |V
0x00000000%0  8a 76 01 Sa 4o 02 8a 6o 03 od 13 66 61 73 lc fe v H..n.l fas.b
0=x0000000040 4e& 11 75 Oc 80 7e 00 80 O0f 84 8a 00 b2 80 &b 24 Hou .~ 1.5
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Ox00000000D00 o8 83 00 b0 df et &0 o8 7c 00 bD ff o6 64 28 75 & . “he'e|. " yedéu
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0x00000000F0 43 50 41 75 32 81 €9 02 01 72 2e 66 68 07 bb 00 CPAu2 o, v, fh.ow.
Ox0000000100 OO0 &6 &3 00 02 OD DD &6 &3 03 DD 0D OO 66 53 66 Eh....fh... . E5f

0x0000000110 53 &6 S5 &6 &8 00 00 00 00 &6 &8 00 7c 00 00 & SEUEh th.|. .
Ox0000000L20 &1 &8 00 0D 07 od 1a S5a 32 f6 =a 00 7c 00 00 od sh, . . I Z2aa | .1
0=0000000130 18 ad b7 07 ab 08 ald b& 07 &b 03 ad bS 07 32 =4 Loe.Em PoE p 28
Ox0000000L40 05 00 07 8b £0 ac 3c 0D 74 09 bb 07 00 b4 D= cd Y- T TS |
0x0000000150 10 eb £2 £4 eb £d 2b c% ed &4 eb 00 24 02 eb {8 eoder+Eade, 5, ap
Ox0000000L60 24 02 3 49 62 76 81 6c 69 64 20 70 61 72 74 89 £ EInvalid parti
0x0000000L70 74 69 6f 6= 20 74 61 62 6c 65 00 45 72 72 6f 72 tion table. Error
O=z0000000180 20 &c &F 61 &4 &9 6e &7 20 &f 70 65 72 &1 74 &9 loading operati
0x=0000000290 é&e &7 20 73 79 73 74 65 6d 00 4d &9 73 73 &9 ée ng system Missin
Ox00000001LA0 &7 20 & 70 65 72 61 74 &9 62 &7 20 73 79 73 M g operating syst
0x000000DLBOD &5 &d 0D 0D OO &3 7b 9a bb c2 83 1d 00 00 80 20 en. ..o . »h. ...
Ox00000001C0 21 00 07 fe ££ ££ 0D 08 00 0D OO £0 7f 3= 00 0O V. . b¥¥ &,
Q0000000200 OO0 OO0 OO0 0D OO0 00 OO0 OO0 OO0 OO0 OO OO0 OO0 00 OO 00

Ox00000001E0 OO OO0 OO QD OO0 OO0 OD OO OO0 OO OO OO OO OO OO OO .. .............
0x00000001F0 OO0 0D OO0 0D OO0 OO0 OD 0D OO0 OO0 OO0 OO0 OO0 OO 55 as ... ........... LLE] b

A Careless use of the Edit Sectors function may result in the irreversible data corruption.
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Send Log Files

The program enables to simplify the procedure of sending support requests to the Paragon Support Team. In case of
having difficulties with handling the program, you, with the help of this very function, can address the company support
engineers and provide them with all the information they need such as the disk layout, performed operations, etc. in
order to tackle the encountered problem. Information of that kind is stored in Log files.

In order to send log files to the Paragon Support Team you should take the following steps:

1. Callthe Send Log Files dialog in the Main Menu: Tools > Send Log Files;

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

2. Provide a customer name and a product serial number;

3. Give a detailed description on the encountered problem.

Send log files

/; Send log files.
" Please enter short description of your problem and send log fles bo support

Customer Name
John Smith
Cerial Mumnber
(% de-654ac-a4%c-Tdaf §-237a2|
Conbent of inguiry
Help!

By clicking the Send button the built-in mail client will generate a template request with attached compressed log files
and then send it to the Paragon Support Team.
Log Files

Log files are simple textual files that can be opened by any text editor. There are several log files automatically
generated by the program:

Stubact.log Contains in-depth information on parameters and performance of all operations
carried out by the program

Pwlog.txt Besides brief overview on operations it also contains detailed information about the
state of all hard disks®

Cdb.log Contains low-level information on the CD/DVD devices used in the system

BioNTlog.txt It is an OS-dependent supplementary log file derived from Bioxx.dll. It may contain
valuable information on Windows family operating systems
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Log files do not contain any confidential information on the operating system settings or
the user documents.

A The Send Log Files function is only available when outgoing mail server (SMTP) and the user
e-mail address are properly set. To learn more about it please consult the Settings
Overview chapter.

View Logs

With a handy dialog you can study logs on any operation carried by the program. To make this job as easy as possible, all
the information is structurally divided, besides there is the possibility to see the disk layout before and after an
operation, what is very convenient.

In order to view logs on carried out operations select in the Main Menu: Tools > View Log Files

=
= 8 § & 7| (=

[ Segmora
Session event
Started 9732000 at 12-40-45 AM. Fnished at 12:41:21_..
Started 9732009 at 124211 AM. Fnighed at 124429
Started 9732000 at 12-45:04 AM. Fnished at 124512 ...
¥ Sarted 332009 ab 12-45:39 AM. Freshed at 1:28:51
¥ Started 9272009 at 9:17:40 AM. Finished at 3:21:28 AM Mo operations have besn found for the selected sasson.
¥ Started 322009 ab 93036 AM. Finished af 34104 AM
8 Stared 9272009 at 9:41:05 AM
¥ Sarted 3272009 a 12-15:48 PM. Fnished at 12:20:26...
¥ Started 9272009 ab 12-20:25 PM. Frished at 12:24:46...
B Sarted 322009 at 12-24:46 FM
¥ Started 3272009 at 12-06:15 PM. Frished at 12:07-47_..
¥ Saded 322009 a 120747 PM. Fnished at 12:21:18...
5 Starbed 9272009 at 12-21:18 PM. Firished at 12:30:15...
Sared 322009 at 12-30:15 PM. Fnished at 12:31:33..
Started 3722009 at 12-31:33 PM. Fnished at 12:41:47...
Sarted 322009 at 12-44:44 PM. Fnished at 12.58:38...
5 Starded 37272009 at 1:08:03 FM

Dok Syton Corbpaton A Seson
Basic Hard Disk 0 (YMware, YMware Vilual 5 SC51 Disk Dev) - OF Basic Hard Disk 0 (VMware, VMware Virual 5 SC51 Disk Dev) - Off
W (C) W (€
NTFS NTFS

Basic Hard Disk 1 (VMware, ViMware Viflual 5 SC51 Disk Dev) - OFf Basic Hard Disk 1 (VMware, VMware Vilual 5 SC51 Disk Dev) - OfF

e l— [ ——
FREE FREE

Basic Hard Disk 2 (Viware, Viware Virual 5 SC51 Disk Dev) - OF Basic Hard Disk 2 (Viware, Vilware Vinual 5 SC51 Diske Dev) - OF

[ — [
FREE FREE

Typical Scenarios

This chapter lists a number of the most frequently used scenarios that may be accomplished with the program. You can
find here useful recommendations and descriptions of operations.
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Backup Scenarios

Backing up a hard disk or partition to a network drive

To back up an entire hard disk or a separate partition and then place the resulted image to a network share, please do
the following:

1. Click the Simple Backup item of the Wizards menu.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

2. Onthe Wizard's Welcome page, click the Next button.

3. Onthe next page, mark the appropriate option opposite a hard disk’s name or a partition’s name depending on
the chosen task.

Click the check box next to any hard disk drive or partition you want to back up

Name Type -
= Gl My Computer My Computer
& 8 [Z] Basic Hard Disk 0 (VMware, ViMware Vitual $ SCS! Disk Dev) Intemal Hard Disk Driv
| #55 First Hard Disk Track Frst Track
] € Master Boot Record MBR |
€= oconse) [ ]
5 [7] {5] Basic Hard Disk 1 (VMware, VMware Vitual S SCS! Disk Dev) intemal Hard Disk Driv
| £ First Hard Disk Track First Track
| 5 Master Boot Record MBR
7 &9 Local Disk (E) Prmary
] @ Local Disk (1) Pramary
J Local Dk () Prmary
7] € Local Disk () Prmary

| [5] Basic Hard Disk 2 (VMware, VMware Vitual S SCS! Disk Dev) Intemal Hard Disk Driv ~

The size of objects to back up: 499.9 GB
Estimated archive size 7.2 GB

4. Map a network disk to place your backup image to:

- Call the Map Network Drive dialog by clicking the appropriate button;

Select o folder whene archive should be placed and specify archive name. Archive name will be used a5
subfolder where backup data fies will be stored.

Archive location: |C-/are_03090907155127%/ - K 2
Namd " Map Netwark Drive (-5 esa] P2
= G

Flamate location mapping

Anatwork shars - || L]
”; Map to dive letter : | 7 [

[] Make permanent connection

%) Connect as user 0K Cancel

- Click the standard browse button [...] to browse for the required network share or manually enter a path to
it;

- Define a letter from the pull-down list of available drive letters;
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- Mark the checkbox to make this connection permanent. Otherwise it will only be available for the current
Windows session;
- Click the Connect as user button at the foot of the dialog page to specify a user name and password to
access the selected network share if necessary.
5. Edit the archive name if necessary.

Please specify the archive name. Archive name will be used as a subfolder where backup data fies wil

be stored
Archive detals
Archive name arc_030509071001085
Estimated archive size 44GB

Space avaisble on backup destnation: 38 GB

Please take into account values of the parameters Estimated archive size and Space
A available on backup destination - if the archive size exceeds the available space, another
network drive needs to be selected.

6. Add comments to your backup describing its contents.
Plaase anter a shod comment bo describa the archive
h Mo comment

7. On the Backup Summary page review all parameters of the operation and modify them if necessary. Click the
Next button to start the backup process.

A This operation can also be accomplished with our recovery media.

Backing up a dual boot Mac to an external USB drive

To back up a dual boot Mac (Mac OS X and Windows XP/Vista/7) and then place the resulted image to an external USB
drive, please do the following:

1. Start up the computer from our Linux/DOS recovery media.

Recovery Media Builder can help you prepare our recovery environment either on a

2 CD/DVD disc or a thumb drive.
To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Connect an external USB drive to the computer.

3. Restart the computer. It will be automatically started up into the Linux recovery environment (Normal Mode),
since it’s the only mode that provides support for Mac computers.

4. Inthe Linux launch menu select Partition Manager.
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5. Launch the Backup Wizard by selecting in the Main Menu of the program: Wizards > Backup Wizard.

Operations Help

Copy Hard Disk

d GPT Disk 0 (V

One Bution Copy Wizard =
pple HFS leop NTFS [Ho label)
- EI - k v "‘II: IJJd

SimpleResone Wizand

isk 1 {28 -2700C

I Undelete Pantitions

File Transher Wizard

—————— Boot Corecior )
| GFT Disk 0 drive, Size 112 Gb

me [TYpe | pemork Configurator sed |Free [Volume label
ed GPT Disk 0 {Size 112 Gb)
Primary FAT32 200 Mb 15.0 Mb 185 Mb EFI
Primary Apple HFS 549 Gb 142Gb 407 Gbhb  leaopard
Primary Free 128 Mb
Primary NTFS 566 Gb 109 Ghb 45.7 Gb Mo label]

6. On the Wizard's Welcome page, click the Next button.

7. On the What to back up page, select your Mac hard disk.

[retained GPT Disko | Model VMware Vinual IDE Hard Drive, Size 112Gb
[N Tvolume [Type |File Sysiem  [Size Jused [Volume label  [Active |
Retained GPT Disk 0 (Size 112 Chi
1 " Primary Appla HFS 549Gh 142 Gb leopard Mo
E R Primary NTFS S%EGhE  108Gh  [Mo label] Yes

8. On the Backup Destination page, select the Save data to any local drive or a network share option.
Please select how would you like 10 save the archive

(%) Save datato any local drives or a network share

Choose this option if you want o save your data 1o kcal
mounted or physical partition, 1o USE or FireWare exiernal
drives and 0 a mounted network share. You will be prompied o
choose a lbeation you want io S ave the archive o,

) Burn data to CD/DVD
Choase this option if you want the Wiz ard 1o burm the archive 1o
CDor DVD. You will be prompted %o choose a CDor DVD RW
drive.

9. Select an external USB drive as a backup destination.
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Specify image file to create

Look in: |” (NTFS, 2 om Disk 1) (UFSD disk - 4bp) ‘"l [—ﬁ]
i rchive
i) SRECYCLEBIN
i) -Trashes
o
) RECYCLER
) Sysem Volume Inform ation I D
=) head
- g
[ Renameire | [ mewhider(Fn) | | Delete (FB |
Ml | File name: |tmg_l)c| plsf I | Save |
File type: [image files (* pbi |
| <Bak | Hex> | | Cancel ]

10. Edit the archive name if necessary.

~ Backup destination -

Archive nams

]-ll:-i"..-'..-- 1B ackup Ssorageimg D0 pbi I[Zi

Space available on destination: 34.8Gb

Approximate archive size: 17.5 Gb

available on backup destination - if the archive size exceeds the available space, another

f Please take into account values of the parameters Estimated archive size and Space
drive needs to be selected.

11. Add comments to your backup describing its contents.

o~ BPERIVE XL COMMEnT -
Please enter backup comments 1o describe the archive

|archive 1ma_D0 pb, created: 200806.05 13:42 39 |

12. On the Backup Summary page review all parameters of the operation and modify them if necessary. Click the
Next button to start the backup process.

A This operation can also be accomplished under Windows.

Recovery Scenarios

Fixing MBR after a boot virus attack

Let’s assume that the MBR (Master Boot Record) of your hard disk has been corrupted as a result of a boot virus attack,
thus your system fails to boot.
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To fix the MBR of your hard disk, please do the following:

1. Start up the computer from our Linux/DOS recovery media.

Recovery Media Builder can help you prepare our recovery environment either on a

2 CD/DVD disc or a thumb drive.
To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Inthe boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe Mode
to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the
option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware
incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and
keyboard drivers. This mode has simple graphics and a simple menu.

A By default the Normal Mode will be automatically initiated after a 10 second idle period.

3. Inthe Linux launch menu select Boot Corrector. You can find it in PTS DOS as well.

4. On the Wizard's Welcome page, select the Correct the Master Boot Record (MBR) option.

Flease choose the operation

() search for Windows installations 1o corect
(&) Correct ihe Master Boot Record (MBR)

() Correct the partition boot record

O Hd-dlf',.' PArMMOnR Balameélers

) Corrett boot parameners (boot.ini, BCD)

To begin, click Mext

5. On the next page choose the required hard disk from the pull-down list (if several) and then select the Update
the MBR executable code option.

Please choose the hard disk o correct boot problems

A

Flease pointout the operation o perdorm:

) view the MER
(& Updare the MER executable code

) Reorder primary panitions (change skots)

6. Confirm the operation.

i ‘ Updae the MBR executable code of the Basic Disk 0 (40.0 Gb)7

5=
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7. After the operation is completed click the Report button to see a well informative summary page. The program
also enables to store the resulted report. To do that, just press the Save button and choose the exact location in
the opened dialog.

Reporting

" You have successfully completed boot cormection, To view the repan
on the operations perdormed, click Report

Report

Paragen Beol Correcier’s Repon

Operations pedormed:

Operation #1; Correct the Master Boot Record
Hard disk targeted: Basic Disk 0

Staus: Successiul
Date and Time: 2009 Jan 14 Wed 140109

8. Click the Finish button to close Boot Corrector.

9. Reboot the computer.

Fixing Windows startup ability

Let’s assume that due to an unknown reason your Windows fails to complete the startup procedure. At first everything
seems quite OK, you can see the standard startup messages on the screen, but at some moment it hangs up.

To fix your Windows startup ability, please do the following:

1. Start up the computer from our Linux/DOS recovery media.

Recovery Media Builder can help you prepare our recovery environment either on a

f CD/DVD disc or a thumb drive.
To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Inthe boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe Mode
to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the
option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware
incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and
keyboard drivers. This mode has simple graphics and a simple menu.

A By default the Normal Mode will be automatically initiated after a 10 second idle period.

3. Inthe Linux launch menu select Boot Corrector. You can find it in PTS DOS as well.
4. On the Wizard's Welcome page, select the Search for Windows installations to correct option.
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Flease choose the operation;

(*} search for Windows installations 1o correct
O Correct the Master Boot Record (MER)

O Correct the panition boot record

i Modify partition paramesers

() Correct boot parameters (bootini, BCD)

To begin, click Mext.

5. On the next page choose the required Windows installation from the list of found installations (if several), then
select the Edit the Boot.ini file option. If you’re not sure which installation you need, please use the Properties
button to get more info on the selected item.

Correct Windows installations

Pragram has searched for valid Windows installations on your
computer, The results of the seaich you can e below, Stalus 5 reler
10 a system partition (you can edit the Bootini file), B - a boot panition
{you can correct the System Registry).

N |Panitan |Staws [sysem oot [Type
1  Disk 0, Partition 0 5+B  WINDOWS winxp

For the highlighted Windows installation, please

paint out the operation o perdorm:
) Correct drive letiers in the System Registry
(%) Edit the Boot.ini file

) Correctthe partition oot record

Adjust 05 1o oot on new hanrdware

Ta continue, click Mext

6. Examine the file — maybe that’s where the problem is. If it contains a mistake, correct it by using the appropriate
buttons.

Edit the Boot.ini file on Hard Disk 0, Partition 0

[boat loader]

timeout=10

defauh=mulitOdiskiDirdisk(Dip anition] IWINDOWS

[operating systems)

multi{00di sk (0rdisk (D) p anition( IWINDOWS ="Paragaon VikiWare Windows XP Partition 01° fasideisct 1

Com ] [_we  J[__w1 ] [ oo ]

i Edin ] l Insert the sample || Add the sample ]

7. If the Boot.ini file does not contain any mistake, please return to the Correct Windows Installations page to
correct drive letters in the Windows System Registry.
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Correct Windows installations

Program has searched for valid Windows installations on your
computer. The results of the search you can see below, Status S refiers
1o & sysiem panition (you can edit the Boot.ini file), B - a boot panition
(you can correct the System Regisiry).

|[N |Panition
1 Disk 0, Partition 0

f""-'p-e
WinxP

|S1aws |System mot
S5+B  WINDOWS

For the highlighted Windaws installation, please
point out the operation o perform:

(= Correct drive leners in the Sysem Regisiry
) Editthe Bootini file
(} Correct the partition boot record

Adjust 05 o boot on new handware

To continue, click Rext,

8. On the next page choose a hard disk from the pull-down list (if several), then the required partition. If you’re not
sure which installation you need, please use the Properties button to get more info on the selected item.

* Panitions List | Lefiers Map

Below you can choose a hard disk drive and see all panitions on it Information about drive letiers
assigned 1o these panitions |s 1aken from the Sysiem Regisiry of the Windows installation selecied.

[Basic Disk +| 400 Gb, VMware Virtual IDE Hard Drive
N [Type |active |Fite System  [volume 1abel |Size |Drive leters |
0 Primary Yes  NTFS Winxp 30Gb =
1 Primary Mo NTFS Application  9.8Gh E
?  Primary Mo BackupCapsul [Ho label) 100 Gb <Mone>
3 Primary Mo Free 17.2Ghb <Mones

Click the Edit Letters button to correct an existing drive letter or assign a new one in the Windows System
Registry.

9.

Partitions List

Beelow you can Drive letters it. Informiation about drive letiers

assigned 1o thess the Windows installation selecied.
Basic Disk D Ll Dirive
N [Type Eng | Drive: leners
0 Primary T b <Mone>
1 Primary b E:
2 Primary Add I Gh wMNonE =
1 Primary — Gb  =Mones
Recommended 1o try - C:. If used,
you can release itin Leters Map.

Properties |

Close

10. Once you’ve assigned the appropriate drive letter, close the dialog, then click the Apply button.

11. Confirm the operation.
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“ Apply the changes?

Ly J[_™ |

12. After the operation is completed click the Report button to see a well informative summary page. The program

also enables to store the resulted report. To do that, just press the Save button and choose the exact location in

the opened dialog.

Paragon Boot Correcior's Report
Cperations performed

Operation £1: Change dive leneis

Partition tangesed: Hard disk 0, Panition ©
Info: System Root folder is ™~ fpuser, If
Status: Successiul hnd make
Daie and Time: 2009 Jan 14 Wed 16:14:16

e Togo o the beginning, click here

13. Click the Finish button to close Boot Corrector.

14. Reboot the computer.

Restoring a dual boot Mac from an external USB drive

Let’s assume that your Mac fails to boot because of a hard disk malfunction. But you’ve got a backup of your hard disk
on an external USB drive. Just replace the failed disk with a new one and carry out a bare metal restore.

To restore a dual boot Mac from a backup image located on an external USB drive, please do the following:

1. Start up the computer from our Linux/DOS recovery media.

Recovery Media Builder can help you prepare our recovery environment either on a

2 CD/DVD disc or a thumb drive.
To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Connect an external USB drive to the computer.
3. Restart the computer.

4. Inthe boot menu select Normal Mode to use the Linux recovery environment, since it’s the only mode that
enables to work with USB devices.

A By default the Normal Mode will be automatically initiated after a 10 second idle period.

Copyright© 1994-2011 Paragon Software Group. All rights reserved.



85

5. Inthe Linux launch menu select the Simple Restore Wizard.

6. On the Wizard's Welcome page, click the Next button.

On the What to Restore page, click the standard browse button [...] to find the required archive. When done,
double click on it to select.

Select archive...

File mame: ||l.':-_ vista.pbi |

File type: [asenive fites = pbi v] | cancel |

< Back it Cancel |

8. On the Image Properties page, make sure that you select the correct image by viewing the provided information
about the archive.

~ Disk preview

Volume [Type |File System |Size [Used [volume label |
Basic Disk 0 (Size 112 Ghb)

. Primary FATI16 00 Mb 15.0 Mb [Ma label

- Primary Apple HFS 549Ghb 14.2Gb lespard

. Primary HTF5 566 Gb 109 Gb [Ma label]
Aschive details: ~
Type: Image of the hard disk
Archive namea: ME0528hddNeo_vistaleo_vista pbi
Created; 2008 May 29 Thd 21:16:51 e

To contimue resiore process, click Next,

9. On the next page specify a hard disk to restore the image to.

Basic Disk 0 (VMware Virtual IDE Hard Dri

Basic Disk 1 (28)- 279 Gb
: NTFS ntfs4backup

[Basic Disko | Model Viware Virtual IDE Hard Drive, Size 112 Gb

N |volume |Type | File System |Size |volume label  [Active  [Hidden |
Basic Disk 0 {Size 112 Gb)

0 = Prirmary Fres 112Gh Mo Mo
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A All contents on disk selected for restoring purposes will be deleted during the operation.

10. On the Restore Summary page you can see your hard disk layout before and after the operation. Click the Next
button to initiate the restore process.

Vewchames on

Your partitions before operations:

- |

Your partitions after operations:

- Apple HFS leopard NTFS [Ho label]

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

Operations list Suboperation progress
1: Restore parition or disk [! |
Operation progress
| |
Time elapsed:  00:00:16 Time o finish: 002624

Copied sofar: 1920 Mb Read so far 192.0 Mb(24.0 Mbys)
To copy: 14.0 Gb  Write o far 192.0 Mb(38.4 Mb/sh

Crverall progress

Convening disk 0 o GPT

Opening archive beo_vista_0000p 000..

Restore Primary partition O (disk 0) from file: /r90528hddleo_vistaleo_vista_0000p 000
Duata writing

Opening archive leo_vista_0001p 000

Restare Primary partition 1 (disk 00 from file: /19052 8hddleo_vistalea_vista_0001p 000
Doata writing...

12. After completing the operation close the wizard, and then reboot the computer.

Copying of data from the corrupted system disk to another hard disk

To retrieve valuable information from your hard disk and copy it to another hard disk when the system fails to boot,

please do the following:
1. Connect the second hard disk to the computer.

2. Start up the computer from our Linux/DOS recovery media.

Recovery Media Builder can help you prepare our recovery environment either on a

f CD/DVD disc or a thumb drive.
To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.
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3. Inthe boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe Mode
to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the
option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware
incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and
keyboard drivers. This mode has simple graphics and a simple menu.

A By default the Normal Mode will be automatically initiated after a 10 second idle period.

4. Inthe Linux launch menu select the File Transfer Wizard. You can find the same wizard in PTS DOS as well.
5. Onthe Wizard's Welcome page, click the Next button.
6. Select a disk where the files you need are stored from the pull-down list in the right pane of the page.

Source

W My computer

' / (Rootdin

W MyComputer (My computer)
M /mnt (Mounted resources)
' /mnydisk (Local disks)

E W /media (Removable disks)

& IDE CD/DVD (NECVMWa VMware IDE COR1
~ EYEX TR
“@* D)\ (NTFS, 1on 2isk 0) (Application)

e E\ (BackupCapsule, 2 on Disk 0) (UFSD di:
T nudr [~

7. Select files you want to copy and place them to Clipboard by pressing the left arrow-button.

Clipboard Source
(77 /mnydisk/hdal/Documents and Settin [‘ Jsel E
(3 imndiskmdalDocuments and Settin o A
J Application Data
J Cookies
@ ) Deskiop
' ) E-Mail Database
@ J Favorites
_J Local Settings
J My Documents
. NetHood
) PrintHood
< > ) Recent v
Totaldata size: nfa [ Cak ] [ Rename (F6) ] [ Delete (F® ]

Click the Calc button to estimate the resulted data size.

8. On the Select Destination Type, choose the way the data will be stored. Select the Save data to any local drive
or a network share item.
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Please select how would you like o save the data:

(% Save data to any local drives or a network share
Choose this option il you want 1o $ave your data o lbcal
mounted or physical panition, 0 USE or FireWare external
drives and to a mounted network share, You will be prompted o
choose a location you want i sawve the archive o,

) Burn data to CO/DVD
Choose this option il you want the Wizand w burm the data o

CDor DVD. You will be prompied 1o choose a CD or DVD RW
drive.

9. On the Select Destination Path page, select a hard disk to copy the data to by pressing the standard browse
button [...].

Select path

limnydisihdaz ”:I

Space avallable on destination: 8.6 Gb

Totaldata size. nfa Calk

10. On the Transfer Summary page check all parameters of the operation. Click the Next button to accomplish the
operation.

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

Operations list: Suboperation progress

l?T'dﬂ*llﬂG’dﬂl :Ii“...ll.'.l....llll.ll‘ll-.-.lll.ll...'illll..l..ll‘]

Operation progress

lonl'l-i'-u-.--l-'lbcnuuuunliicnnu'--n-.u-u-un-n-nllll

Time elapsed:  00:00:03 Time w finish 00:00:00

Copled so farr  17.0 Mb

Overall progress

T T T T T T T T

Transfering “/mntdisk/hdal/Documents and Settings/User/E-Mail Database” © “/mntdisk/hd a2/E-Mail Data
Transfering "/mntdisk/hdal/Documents and Settings/User/My Documents® to “/mntdisk/hda2/My Document
All operations have been finished

12. After the operation is completed, close the wizard by pressing the appropriate button.

13. Turn off the computer.

A This operation can also be accomplished with our recovery media.

Burning of data from the corrupted system disk to CD/DVD

To retrieve valuable information from your hard disk and burn it to CD/DVD when the system fails to boot, please do the
following:

1. Start up the computer from our Linux/DOS recovery media.
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Recovery Media Builder can help you prepare our recovery environment either on a

f CD/DVD disc or a thumb drive.
To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Inthe boot menu select Normal Mode to use the Linux recovery environment, since it’s the only mode that
enables to burn CD/DVD discs.

A By default the Normal Mode will be automatically initiated after a 10 second idle period.

3. Inthe Linux launch menu select the File Transfer Wizard. You can find the same wizard in PTS DOS as well.
4. On the Wizard's Welcome page, click the Next button.

5. Select a disk where the files you need are stored from the pull-down list in the right pane of the page.

Source

i My computer
™ / (Rootdin
W MyComputer (My computer)
M /mnt (Mounted resources)
W /mnydisk (Local disks)
E W /media (Removable disks)
0' IDE CD/OVD (NECVMWa VMware IDE CDR1
- EYETeTT—
“e* D)\ (NTFS, 1on 2isk 0) (Application)
e E\ (BackupCapsule, 2 on Disk 0) (UFSD di:
T nudr v

6. Select files you want to copy and place them to Clipboard by pressing the left arrow-button.

Clipboard Source
(7 /mnydisk/hdal/Documents and Settin I‘ Jser q
(3 imndiskmdalDocuments and Settin o A
) Application Data
) Cookies
@ ) Deskiwop
' ) E-Mail Database
@ ) Favorites
) Local Settings
J My Documents
) NetHood
) PrintHood
< > ) Recent v
Totaldata size: nfa [ Cak ] [ Rename (F6) ] [ Delete (F8 ]

Click the Calc button to estimate the resulted data size.

7. On the Select Destination Type, choose the way the data will be stored. Select the Burn data to CD/DVD item.
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Plaase select how would you like 1o $ave the data

()} Save dala ta any local drives or a network share

Chaose this option if you want o save your data o local
maunted or physical parition, o USB or FireWare external
drives and o a mounted network share. You will be prompied w0
choose a locathon you wanm o save the archive

(%) Burn data to CO/DVD

Choase this optian if you want the Wizard o burn the data o
CD or DVD. You will be prompted to choose a CD or DVD RW
drive.

8. On the Choose a Recorder page, select a recorder from the list of available devices and then set a volume label
by entering it in the appropriate field.

Sebect a recorder w0 burn data v

Vendor |Product |Tvpe |
Optiarc DVD RWAD-T1704 CD-R; CD-RW, DVD-R
Volume label |M',.l Datd I

9. On the Transfer Summary page check all parameters of the operation. Click the Next button to accomplish the
operation.

10. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

Operations list: Suboperation progress
[
1: Transfer userdata | |
Operation progress
[(TIITTITITITTI J
Time elapsed.  00:00:07 Time 10 finish: 00:00:16
Copied sofar. 5.0 Mb
To copy: 12.0 Mb
Overall progress
é,:!_ﬂ_lﬂ!hllll.ﬂil’ ]

Creating compilation image

Used burner: DVD RWAD-7170A Vendor: Optiarc
Session opening

Data burning...

11. After the operation is completed, close the wizard by pressing the appropriate button.

12. Turn off the computer.

A This operation can also be accomplished with our recovery media.

Copying of data from a backup to the corrupted system partition

The system fails to boot since some files are damaged. If you have a backup of the system partition, you can recopy
these files to make the system be operable again:

1. Start up the computer from our Linux/DOS recovery media.
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Recovery Media Builder can help you prepare our recovery environment either on a

f CD/DVD disc or a thumb drive.
To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Inthe boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe Mode
to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the
option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware
incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and
keyboard drivers. This mode has simple graphics and a simple menu.

A By default the Normal Mode will be automatically initiated after a 10 second idle period.

3. Inthe Linux launch menu select the File Transfer Wizard. You can find the same wizard in PTS DOS as well.
4. On the Wizard's Welcome page, click the Next button.

5. Select a disk where the system backup is stored from the pull-down list in the right pane of the page.

Source

)

) DIFF128565184 710000000
e apc_2BOSOB1347) 7531 PRF
= arc_280508134627531 pim

6. Double click on the required backup to open.

Source

) -
i | Dacume%; and Settings
I Program Files

) RECYCLER

—J Sysem Volume Information
) WINDOWS

= cfiles svigz

= AUTOEXEC BAT

=) NTDETECT.COM

ﬁ bootini

E nitkdr 7

7. Select files you want to copy and place them to Clipboard by pressing the left arrow-button.
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Clipboard Source

(] WINDOWS/system (mnidisk/hda2/8 [wiNpow ]

) provisioning
) pss

) repair

) security

J srchasst

) system

) sysem32
J twain_32

= okog

= 001947_1mp
2 ; ERL "

(B,

Total data size: 904 Kb

Click the Calc button to estimate the resulted data size.

8. On the Select Destination Type, choose the way the data will be stored. Select the Save data to any local drive
or a network share item.

Please select how would you like o save the data:

(%) Save data to any local drives or a network share
Choose this option il you want 0 save your data o bcal
maumted or physical panition, 1 USB or FireWare exernal
drives and to a mounted network share, You will be prompted o
choose a lecation you want i sawve the archive 0.

) Burn data to COYDVD

Choose this aption il you want the Wizard © burn the data w
CDor DVD. You will be prompied o choose a CD or DVD RW
drive.

9. On the Select Destination Path page, select your system disk to copy the data to by pressing the standard
browse button [...].

g _ [
0 INtServicePackUninstally

2 AppPatch

) Config D

) Connection Wizard

) Cursors

=) Debug

) Downioaded Program Files
) Driver Cache

i EHome -

Frerame (F6 [ Mew folder (F7) ]

File name: ] mintidisk/hdal WINDOWS | Select |

|
File type: ] I files (.4 | Cancel
Help < Back il Cancel

10. On the Transfer Summary page check all parameters of the operation. Click the Next button to accomplish the
operation.

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.
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Operations list: Suboperation progress

II'I SEENESERENRENNEREREENERENNERENRENEERER RSN I'Il

1: Transfer user data

Operation progress

Time elapsed:  00:00:04 Time w finish: 00:00-00

Copied so far: 0.9 Mb

Cverall progress

Transiering “AVINDOWS/system” 1o "/mnydisk/hdal WINDOWS [system” - em 1 of 1
All operations have been finished

12. After the operation is completed, close the wizard by pressing the appropriate button.

13. Turn off the computer.

A This operation can also be accomplished with our recovery media.

Restoring separate files and folders from a backup

The program provides a very convenient option to access backup archives and restore only data you need (the so called
selective restore functionality).

Volume Explorer
To restore separate files and folders from a backup image with Volume Explorer, please do the following:

1. Click the Disk View tab and then choose Volume Explorer;

Hame Size Modfied
 @Hlicoovwomwes 00000
Mg = 1 Hard Disks
Vil =1 [E] 1. ViMware, Viware Vitual S SCSI Disk Davi 500 G
1. Prmary NTFS [T} 499.9GB
% [F] 2 VMware, VMware Vidual $ SC5I Disk Devi 0GB
= _] 3 Viware, Vidware Vitual 5 SC51 Dk Dew 80 GB
-8 1. Prmary NTFS (5 419GE
# B2 Backup Capsule B|GE
@ [5] 8. VMware, VMware Virtual 5 SCSI Disk Devi (GPT Disk)
%1 & Vitual Drives

2. Browse for the required archive and then open it by double click of the left mouse button.
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 Disk View  Scheduled Tasks | Archives | Help |

MName Size Madfied

& [F] 3 VMiware, Vibware Vitual § SCS) Diskc Devi 0GB

= ﬁi Primary NTFS 57 419GE
B are_disk2 QE2009 4:25:00 AM
& ] arc_doc 8/2/2009 4:05.42 AM
B arc_images 9/3/2009 E:45:37 AM
&= :_ﬂn_,n'inm S/2/2008 1:41:04 AM
% arc_system 001 18GE  5/2/2009 1:47.04 AM
1968 5727200913732 AW

5 1. Pasition 459968
arc_system pem 156 Bytes 97272009 1:41:03 AM
| arc_system pfm GE3IKE /272009 1:41:04 AM
- System Volume Informaticn /272009 4:42:59 AM

# 52 Backup Capsue 38GB

@[] 4. Viware, Viware Vidual § SCSI Disk Deni (GPT Disk)

3. Call the popup menu (right click of the mouse button) for a file/folder you need and then select the Export item.

| Disk View | Scheduled Tasks | Archives | Help |

i Links

g8ses8a

588

/ Vokume Explores

]-8-@

£ SendTo
0 55 Rt Menu

£ Tempiates

288

< |

4. Select a place on the disk where the file/folder will be extracted to.

Lok in: [E] Locsl Disk T E - K¢

Address: | CJSf

Hame | Dt
& || arc_images YA
& s arc_rew X
@ | achds 822t
& . archive_db YA
@ |, Pedlogs T35
- |, Program Files S
- Users 8is
@ Wi =T P
# |, Windows 822t

5. Click the OK button to accomplish the operation.

The current version of the program does not enable to access file archives with Volume
Explorer.
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Resize Scenarios

Creating a new partition to detach operating system from the rest of data

Let’s assume that you’re a rank and file user who is most likely to have only one hard disk with only one partition (the
only partition is always system). To secure yourself against a system malfunction or a virus attack you’ve got nothing to
do, but make a backup of the whole partition, which besides the operating system itself contains all your family photos,
favorite films and music, program distributives, whatever. As a result you’ll get a very huge backup image. You can easily
tackle this issue however by detaching your operating system from the rest of data.

To create a new partition on your hard disk, please do the following:

1. Click the Express Create Partition item of the Wizards menu.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

2. Onthe Wizard's Welcome page, click the Next button.

3. Choose a method you find the most suitable to create the partition. The wizard is especially designed to
minimize your participation in finding an appropriate place for it and its resulted size. The only thing you’re to
do is to choose between several modes. The most relevant thing here is the amount of space that will be
allocated for that partition. For easy perception, you can see the resulted disk layout on the disk map by
selecting this or that mode.

The resut you will gat after applying the changes

Basic Hard Disk 0 (VMware, VMware Virual S SCSI Disk Dey)

l l @) New Volume (E:)

Plaase salact the mathod of new pantion creation
Take all unallocated space at the end of the disk

©) | Smart Mode | ( Use 2433 GBto create a pattion ) More nfo
Advanced Mode {Use 1414 GB o crazte 3 patton ) More nfo

The number of available methods depends on your disk layout.

A To learn more on the way the wizard works, please click the corresponding link on the first
page of the wizard.

4. That's basically it. By clicking the Next button the wizard will start modifying your disk layout. If you’ve got to do
with the system partition resize, like we do in our case, you will be asked to restart your computer in a special
boot-up mode to accomplish the operation. So click the appropriate button to agree.
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.,_ﬂ Express Create Partition Wizard 2 I
Creating the partition Q .
The Wizard is now creatng tha panttion >

Crente sastion

,_? Express Create Partition Wizard ‘—_5— ‘l

" System restart is required to complete the operation.
/ =\, What would you like to do?

The operation Move partition needs axclusve access 1o the volume C: and
Opartio cannct be completed without system restad. After restant, the operation will continue in
= boottme mode. Do not tum off the computer until the operation
completes.

5> Restart the computer
Please confirm restart of your computer. The operation will be continued after
system restant

& Retry

Manually close used filas and ratry the operation

- e Tha cparation cannot be complatad wihout rastat bacause some fiss are in use and
1 St @ pravent axclusive access to the volume

What fles prevent openation complation?

5. Inthe Progress window you can see in real-time a detailed report on all actions carried out at the moment.
After completing the operation your computer will be automatically restarted back to Windows where you can see the
newly created NTFS partition. Now you’ve got a place to keep your stuff apart from Windows.

Increasing size of a system partition by taking unused space of an adjacent partition

Let’s assume you’ve got several partitions on your hard disk. After installing a number of resource-consuming
applications and system updates your system partition has started to suffer from the lack of free space. But an adjacent
partition has a plenty of redundant space. That’s just enough to make your system partition suffer no more.

To increase size of a system partition by taking unused space from an adjacent partition, please do the following:

1. Click the Express Resize Partitions item of the Wizards menu.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

2. Onthe Wizard's Welcome page, click the Next button.

3. Click on your system partition. By doing that, the wizard will automatically select an adjacent partition as well.
This partition will later act as a space donor.
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The wizard will resize space between Local Disk {C:) 2nd New Volume (E:)on Basic Hard Disk O
(Whware, VMware Vitual 5 5C51 Disk Dev)

Selact laft partition from 2 pair of adacent paritions you would ke to resize, Right adiacent parttion will ba
selected automatically

Basic Hard Disk 0 (WMware, VMware Virtual 5 SC51 Disk Dev)

nl @) New Volume (E:)
460 3 GB NTFS

If you’ve got more than two partitions on your hard disk and a partition you need to

Q increase is surrounded by other partitions, you’ve got the choice to choose which partition
will act as a space donor. Just click on the left partition of the pair, as the right one will be
selected automatically.

4. Increase size of the system partition with the slider or manually by entering the required value. Please note,
when you change size of one partition the size of the other will be changed as well, thus redistributing the
unused space between the partitions.

Plaasa spacfy new szes of salacted patitons

Selected part of Basic Hard Diske 0 (WMware, VMware Virtual 5 SC5] Disk Dev)

l l € New Volume (E:)

Laf wolume size Right voluena size

40624 MB | MB J STIBEME 2| MB

5. On the next page of the wizard you need to confirm the operation by selecting the appropriate option.

The \Wizard has not applied your changes yet. On this pags, you can aither accapt or
A raconsider the changes

u sccept the changes, the Wizard wil physically pefom ol the neccessary
t be possble to undo the changes

Please note that #
operations and t wil

Rt may take some time to apply the changes. You may also be asked to rastat your computer duning this
process

VWould you ke to apply your changes 7
Yes. spply the changes physicaly

© | No, let me reconsider. |

6. That's basically it. By clicking the Next button the wizard will start modifying your disk layout. If you’ve got to do
with the system partition resize, like we do in our case, you will be asked to restart your computer in a special
boot-up mode to accomplish the operation. So click the appropriate button to agree.
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’; System restart is required to complete the operation.
/= What would you like to do?
The operation Redistribute partitions nesds exclusve access 1o the voluma C:
and cannat be complated without system restart, After restant, the aperation wil
cartinug in bosttime made. Do not tum off the computer until the operation
completes.

Ié-; Bestart the computer |
Pleass corfim resten of your computer. The cperstion will be continued after |
Sysem nksat |

Manualy close used filas and relry the operation

[ Conce |
7. Inthe Progress window you can see in real-time a detailed report on all actions carried out at the moment.

After completing the operation your computer will be automatically restarted back to Windows where you can see that
your system partition is bigger now.

Increasing size of a system partition by taking unused space from any other

Let’s assume you’ve got several partitions on your hard disk. After installing a number of resource-consuming
applications and system updates your system partition has started to suffer from the lack of free space. But one of your
partitions has a plenty of redundant space. That’s just enough to make your system partition suffer no more.

To increase size of a system partition by taking unused space from any other on-disk partition, please do the following:

1. Click Switch to Full Scale Launcher in the Express Launcher.

2. Inthe main window select the required hard disk (if several) on the Disk Map.

cer

[Z] Basic GPT Hard Disk 2 (VMware, VMwara Vitual S SCSI Disk Dev]

6 Local Disk (7

€ (Unalocated) 473BFFED

g

3

-

'Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev) |

' A.. Data (F:) TEMP (G2)
i 10. 200 GB NTFS 160.3GB FAT32

m

4

3. Choose a space donor partition and then call the context menu for it (right click of the mouse button) to launch
the Move/Resize dialog.
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5.

6.
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i Back Up Partiton...
Burn Partston on €0 or DVD...

Teols Changes Wizards Hard Disk Partition Archives Vi Restore Partition,..
@ & % ’:__}'_ 6 t_ﬂ' Format Partition...
| Disk View | Scheduled Tasks | Archives | Help | Delete Partition...
ol Mame . Move/Resize Part'tl'm‘. |
"I [E] Basic Hard Disk 0 (WMware. Vibwane Vitual S SC5I Desk Dev Convert File System...®
: B Local Disk (T)
) i Change Volurne Label...
& “opbeations (E) z C
= [ Edencdad Partition fmm& E_]'_“E =
E Data (F-} Hide Partition
@TEIJP G Make Partition Primary
il [] Basic Hard Diskc 1 (Viware, Viware Vitual S SCS1 Diskc Dev Change Cluster Size..
&l E_E:ITLT# . . Viwars Vitual 5 SCS1 D Change Senal Number...
- ._'-'I,Id S & LTINS, VTR NI 2 o " Change Partition I0...
- ﬁ Local Disk 7
B (Lnalocated) Wipe Partition...

Clear Free Space...

Test Surface...

| DN 5. Check File System Integrity

Basic Hard Disk 0 (VMware, YMware Virtual 5 5C5| Dish Edit/View Sectors...

A || Data (F:) 10 TEMP '. Properties... i
e 200 GB NTFS || 160.3GB FAT32 | | e ri:

In the opened dialog shift the edge of the partition to the right by the drag-and-drop technique. While doing
this, free space from the partition will be released (displayed in aqua-green). You can also do it manually by
entering the exact size of free space. Click the Yes button to continue.

Are you sure you want to move/resize volume (G:)?

You are about 1o move resize FAT32 volume TEMP, (G:)

Basic Hard Disk 0 (VMware, VMware Virtual S SCS1 Disk Dev)
I @) (Unallocated) .“‘l @) TEMP (G)
1

595GE 00.7 GB FAT22
Volume size: 10316733 M8 #[+] 86 MB- 164.156 MB

Free space before: £0.928.55MB &[] Obytes - 164070.09 M8
Free space sfter. 0 Bypes *[=] Obytes - 164.070.09 M8

Select this option to move partiion areas that dont contain any data, This allows you to keep
the parition’s content after move exactly as & was, but will require more time

Now you’ve got a block of free space to add to the system partition. You cannot do it directly however, but by
carrying out a number of extra move/resize operations.

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)

A.. ‘ Data (F:) I I TEM...
1. || I8 200GB NTFS . 100.7...
= = =

Since the block of free space is within the extended partition, you need to take it out first. The program enables
to resize the extended partition only when there’s a block of free space adjoining its borders. In our case it’s
between two logical disks. So we need to move it. To do that, please select the first logical partition and then
call the context menu for it (right click of the mouse button) to launch the Move/Resize dialog.
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'u* Vieﬁ ] Il Scheduled Tasks Move/Resize Partition.,

| Name Convert File System...

" 5] Basic Hard Disk 0 (Viware, VI Change Volume Label...
@ Local Dek (C) Remove Drive Letter
S;"“-“"’: ' Hide Partition

anded Fartton ols A
GD&B ) Make Partition Primary
@ (Unaliocated) Change Cluster Size...

2 &1ene G) Change Serial Number...
(8] (5] Basic Hard Disk 1 (Viware, VI Change Partition ID...
. @ Loca Disk 1) Downgrade NTFS version...
N [5] Basic GPT Hard Disk 2 (VMwat
Y 65.0\.8 Disk () Wipe Partition...

& Unatocated) Clear Free Space...

8 . J Test Surface...

‘i Check File System Integrity

Basic Hard Disk 0 (VMware, VI Fdt/View Sectars..

Properties...
Data (F:) -
. 200 GB NTFS J | L e I

7. At first shift the right edge of the partition to the right, then do the same with the left edge. Make sure the
partition size has been left unchanged.

Are you sure you want to move/resize volume (F:)?
= You are about to move/resize NTFS volume Data, (F:).

Basic Hard Disk 0 (VMware, VMware Virlual S SCSI Disk Dey)

@) (Unallocated) ©) Data (F)
119GB 1404 GB NTFS |

Volume size: 14387114 MB :~B 94 MB - 265,734 MB

Fres space before: |121.523.00MB &[] Obytes - 265,700.04 MB

Free space sfter. 0 Bytes *[] Obytes - 265.700.04 M8
] Sectorto sactor move

Selact this option to move padition areas that dont contan any data. This allows you to keep
the parition’s content after move exactly as & was, but wil require more time.

8. Now you can resize the extended partition to take the block of free space out of it. Call the context menu for it
(right click of the mouse button) to launch the Move/Resize dialog.

A Call a context menu for the extended partition (with the blue border), not the logical one.

9. Inthe opened dialog shift the edge of the extended partition to the right.
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% Are you sure you want to move/resize extended partition on disk 07

 Basic Hard Disk 0 (VMware, VMware Vitual 5 SCS1 Disk Dev)

LN ez ) @) Data (F) @) TEMP (G:)
LEig 1404 GB NTFS 100.7 GB FAT32
Volume size 2¢703860M8 &[+] 247.038 MB - 368,969 MB

Fres space befors: | 121.530.84 ME ;EUHw-ELSEE.E‘MB

Fres space after 0 Bytes 5

L o T e,

Selact this aption to move partition arsas that don't contain any data. This allows you to keep
the partition’s content aftsr move sxactly as & was, but wil regpuins mos times.

10. The block of free space has been released.

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)
Ap... (Unall...
100. 115GB

11. Now you need to move the second primary partition just the way we did it with the logical partition to make the
block of free space adjoin the system partition.

Data (F:) I TEM...
1404GBNT... || B 1007..

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)

(Unall... Ap... Data (F:) ITE'"-~
119G8 100 .. 140.4 GB NT... 1007.... |

12. Finally increase size of the system partition. Call the context menu for it (right click of the mouse button) to
launch the Move/Resize dialog.

13. In the opened dialog shift the edge of the partition to the right, thus increasing its size.

','(\9‘ Are you sure you want to move/resize system volume (C:)?
T You are about 1o move/resize NTFS voluma [No label], (C:)

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)

I @) Local Disk (C:)
152.7GB NTFS

Volume sze 162.547.31 MB #[¥] 11.680 MB - 162,543 MB

Free space before: | 0.57 ME &[] Obytes - 150,868 20 MB

Fres space after. [ Bytes =] Obytes - 150.260.39 MB
| Sectorto sector move

Select this option 10 move pantion aneas that dont contan any data, This allows you to
keep the partion’s content sfter move exactly 3s & was, but will require more time

14. Apply all introduced changes. By default, our program works in the virtual mode of execution, so you have to
confirm all operations to let the program accomplish them. To do that, just click the Apply button on the Virtual
Operations Bar.
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T[S

Apply pending changes 7

T s o [

15. The program will require the system restart to accomplish the operation in a special boot-up mode. Click the
appropriate button to agree.

Increasing size of a system partition by taking unused space of an adjacent logical partition

Let’s assume you’ve got several partitions on your hard disk. After installing a number of resource-consuming
applications and system updates your system partition has started to suffer from the lack of free space. But an adjacent
logical partition has a plenty of redundant space. That’s just enough to make your system partition suffer no more.

To increase size of a system partition by taking unused space from an adjacent partition, please do the following:

1. Click the Redistribute Free Space item of the Wizards menu.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

2. Onthe Wizard's Welcome page, click the Next button.

3. Select a volume you want to expand, i.e. the system one.

Chocse a volume to expand

Basic Hard Disk 0 (VMware, VMware Virlual S SCSI Disk Dey)

159

l @) New Volume (E:)
83.9GB NTFS

1) Capasty of the voume (C:)is 15.9 GB. The wizard can expand this volume up to 99.9 GB 2t the
epence of other volumes

4. Select a volume to take the space from, i.e. the logical one.

Selact volumes to take space from. Free space from that volume will be used 1o enlarge the volume you have

selected on the previous page
Volume Fle system  Type  Capaciy 'Usedspace 'Freespaoe | % Free
I =€) NTFS logcal 835GB 668MB  833GB

5. On the next page of the wizard you can specify size of the resulted system volume. Drag the slider or type in the
exact value to set the volume size.
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Your disk after the changes:
Basic Hard Disk 0 (VMware, VMware Vilual 5 SCS51 Disk Dev)

Ig;lnn“hﬂtlicil ‘ Ig_yMc—leum[E:}

57.9GB NTFs 47GE NTFS

Salact new size:
59,356 35 MB [+] 16.382 MB - 102.323.47 MB

I Cusent wolume size- 57.9 GB
The vohume size has been increased on 41.9 GB

6. Apply all introduced changes. By default, our program works in the virtual mode of execution, so you have to
confirm all operations to let the program accomplish them. To do that, just click the Apply button on the Virtual
Operations Bar.

=<

Apply pending changes 7

[ Do niot show this message again | Yas 1[ Mo J

Merging a system partition with an adjacent logical partition

Let’s assume you’ve got several partitions on your hard disk. After installing a number of resource-consuming
applications and system updates your system partition has started to suffer from the lack of free space. But an adjacent
logical partition has a plenty of redundant space. That’s just enough to make your system partition suffer no more.

To merge a system partition with an adjacent partition, please do the following:

1. Click Switch to Full Scale Launcher in the Express Launcher.
2. Inthe main window select the required logical volume on the Disk Map.

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)

Local Dis... "H New Volume (E:)
153GBN...

| M £33GB NTFS

3. Call the context menu for it (right click of the mouse button) to launch the Make Partition Primary dialog.

artiion (1] |
sume (E:) ATDCICh ATFEDS:
1 (VWhware, Vihware Visual 5 SC5) Diske Dav)

d) 13FFFFFh |

Change Volume Label...
Remove Drive Letter

Hide Partition

Make Partition Primary
Change Cluster Size...
Change Serial Mumber...
Change Partition ID...
Downgrade NTFS version...

Wipe Partition...

__ Clear Free Space...

| (YMware, VMware Vidual 5 3C51 Disk Dev) Test Surface...

New Volume (E-) Y5 Check File System Integrity
839GE NTFS Edit/View Sectors...
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4. Confirm the operation by clicking the Yes button. By default, our program works in the virtual mode of

execution, so you can either confirm all operations to let the program accomplish them or continue work in the
virtual mode.

@ o )
Are you sure you want to make the partition primary?
You are about to make the parttion (E-) New Volume, NTFS pomary.

L

5. Click the Merge Partitions item of the Wizards menu (any of the ways described earlier can also be used here).

6. Onthe Wizard's Welcome page, click the Next button.

7. Select a volume you want to expand, i.e. the system one.

On this page. you can choose a partition that will be expanded to include adjacent partition. Please note that R is
possbie to saelact only FAT, FAT32 or NTFS partitions. You will not be abla to proceed futher f no adacent
partiions of these types are present on the disk

Basic Hard Disk 0 (VMware, VMware Virdual S SCSI Disk Dev)

I L. I ©) New Volume (E:)
155G. 839GB NTFS

Select a volume you’d like the first volume to merge with. Please note that all contents of the selected partition
will be placed into a specific folder after the merge operation is over.

Sedact an adiacent partition to mergs vith the targst pariion. This parition vwill be merged to the one you hane

selecied on the previous page. The contert of the second partition will be placed in 2 folder insids the resulting
partition

Basic: Hard Disk 0 (VMware, Viwae Vil 5 SCS51 Disk Dev)

lt_.yl |I@hmﬁi]
155G | | £3.9GB NTFS

Specify a folder name o keep contert of the selected partition
Folder Mame  menged_partition _conbent

9. Review the changes and complete the wizard.
10. Apply all introduced changes. By default, our program works in the virtual mode of execution, so you have to

confirm all operations to let the program accomplish them. To do that, just click the Apply button on the Virtual
Operations Bar.

R ==

Apply pending changes 7

Do mot show this message again [ Mo ]
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If you’ve got to do with the system partition resize, like we do in our case, you will be asked to restart your
computer in a special boot-up mode to accomplish the operation. So click the appropriate button to agree.

In the Progress window you can see in real-time a detailed report on all actions carried out at the moment.

After completing the operation your computer will be automatically restarted back to Windows where you can see that

you have the merged volume now.

Shrinking a system partition to increase size of a data partition

Let’s assume you’ve got two partitions on your hard disk, the first one takes about 40% of all the disk space and is
exclusively used for Vista 64-bit, while the second servers as a data storage. One day you realize that your system
partition doesn’t need so much disk space, that’s what your data partition really requires at the moment. You can easily
tackle this problem with Paragon Linux/DOS recovery environment.

To increase size of a data partition by taking unused space from a system partition, please do the following:

1.

Start up the computer from our Linux/DOS recovery media.

A

Recovery Media Builder can help you prepare our recovery environment either on a
CD/DVD disc or a thumb drive.

To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

In the boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe Mode
to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the
option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware
incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and
keyboard drivers. This mode has simple graphics and a simple menu.

.A By default the Normal Mode will be automatically initiated after a 10 second idle period.

3.

In the Linux launch menu select Partition Manager. You can find it in PTS DOS as well.

In the main window select the required hard disk (if several) on the Disk Map.

Hard Disk  Partition Operations Wizands Help

pk | Basi Disk 0 (VMware Viegal - 120 Gb
rage of ha D: NTFS Data
ge of hard
| Disk fron
isk | | Moder viware Viral, Size 120 Gb
[N [volume |Type |File System |Size |used [Free
Basic Disk 0 (Size 120 Gb)
0 C: Primary NTFS 44 .4 Ghb 81Ghb 36.2 Gb
1 D Primany MNTFS 756 Ghb 49 Mb 756 Gb

Choose your system partition and then call the context menu for it (right click of the mouse button) to launch
the Move/Resize dialog.

Copyright© 1994-2011 Paragon Software Group. All rights reserved.



106

Basic Disk 0 (VMware Vinual) - 120 Gb

D: NTFS Data
Create an image of partition... Al-B

Burn an image of partition ko CO/DVD..

Basi Disk

[ m Type Restore partition from image._. AR E
Basic Disk 0 (Size 1 Copy panitien AT
o C Prima 6.2
1 D Prima reais AN 13
Foarmat... Al-F
Delete.. AlD
Wipe paritian AW

Clear free space

Unmount._. rl‘!

Madify 4

6. Inthe opened dialog set a new size for the partition by moving the slider or by entering the exact value in the

appropriate field. While doing this, free space from the partition will be released (displayed in aqua-green). Click
OK to continue.

Partition preview

New size: (8323 - 45434) Mb

::i: = Mb
Free space before: (0 - 37111) Mb
j Mb

Free space afier: (0-37111) Mb

5412 | Mb

Ll

H 1] E

7. Now you’ve got a block of free space to add to your data partition.

Baskc Disk 0 (VMware Virtual) - 120 Gb
_

8. Choose the data partition and then call the context menu for it (right click of the mouse button) to launch the
Move/Resize dialog.

9. Move the slider to the right to increase size of the partition. Click OK to continue.

- Paniion prévies

New size: (8- 102101) Mb

U E

102101 | Mb

Free space before: (0 - 1020931 Mb

-
-

oMb

Free space afier: (0 - 102083) Mb

-
-

Mb
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10. Apply the pending changes.

Applying changes

Jl 2 pending operations
s Apply changes 7
: ™ [ ves || ™ | | Detaits
Undo all | |
[ Apply By ] | You have pending op

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

Operations list Suboperation progress
1: Mave partitsaon I
2: Move partitson Operation progress
[T
Time elapsed:  00:00:58 Time ta finish: 01:35:42

Copied sofar:  248.5 Mb Read so far: 365.9 Mbx (7.8 Mby's)
To copy: 7.9Gb  Write so far: 251.2 Mb (46.0 Mbys)

Owerall progress

Data maving

Creating new partitson _.

Moving drive idev/sdad on hard disk 0

Scanning data structure (may be a few minutes)
{Restart enabled)

Data blocks calculating

Quick data moving ...

Resizing partitions of Apple Boot Camp

Let’s assume you’re a Boot Camp user who's got Windows XP as the second operating system. Initially allocated space
for the Windows partition has turned out to be insufficient for your current needs. The only way out is to take some
space from your Mac partition, thus redistributing the unused space between the partitions.

To increase size of the Windows partition by taking unused space from the Mac partition, please do the following:

1. Click the Express Resize Partitions item of the Wizards menu.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

2. Onthe Wizard's Welcome page, click the Next button.

3. The wizard will automatically select Windows (the NTFS file system) and Mac (the Apple HFS file system)
partitions of your Boot Camp configuration.
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The wizaed vall 1ezize space batwesn Local Dizk [°) and WinkP [C:) on Hetained Bazic GPT Hard
Dizk 0 WMware Yirtual IDE Hard Drive]

Sedact beft parbivon fom a pair of adjacent partitions pou would ke to resize. Fight adiacent patition vall be:
zelected automatically.

Retained Bagic GPT Hard Dizk 0 VM ware Virtual IDE Hard Drive]

I I Local Disk [7) I I WinxP [C:]
54.8 GB Apple HFS 565 GEINTFS

On the disk map you can also see the GPT service partition (called EFI) as well as a 128-

megabyte free block between Mac and Windows partitions made with Boot Camp. It’s just
?
for your information.

4. Increase size of your Windows partition with the slider or manually by entering the required value. Please note,
when you change size of one partition the size of the other will be changed as well, thus redistributing the
unused space between the partitions.

Please specify new sizes of selected partihons
Selected part of Hetaned Basic GPT Hard Disk 0 [VMware Yitual IDE Hard Drive)
l @) Local Disk (%) I I (7] WinXP (C:)
402 GB Aple HFS 71.1 GB NTFS
Left volume size: Right volume sze;
41250MB 3 MB {k 72895MB = MB
5.

On the next page of the wizard you need to confirm the operation by selecting the appropriate option.

The Wizasd has not apphed pous changes yet. On this page, wou can edher accept o
reconsider the changes.

Pleass note that if you accept the changes, the Wizard vill physically pedom al the neccessary
operations and # will not be possible to undo the changes.

It msay take some time to apply the changes. You may also be asked o restat pour computer dunng this
PrOCEss.

‘Wiould you bike bo apply your changes 7
(2)|es, apply the changes physically. |
() Mo, et me reconsidar

6. That's basically it. By clicking the Next button the wizard will start modifying your disk layout. If you’ve got to do
with the system partition resize, like we do in our case, you will be asked to restart your computer in a special
boot-up mode to accomplish the operation. So click the appropriate button to agree.
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System restat is required o complete the operation.
What would you ke to da?

The operabon Hediztnibute partitions needs exchesive access bo the volume C:
and cannot be completed withoul system restart. After restat, the operation il
continue i bool-ime mode, Do nol turn olf the computer unlil the opelation
completes.

-

'_:/ Bestart the computer
Please confirm restart of pour computer, The operation will be continued alter
syslern restar

5 Rety
Marually cose used hles and nslny the operabon

Cancal

7. Inthe Progress window you can see in real-time a detailed report on all actions carried out at the moment.

After completing the operation your computer will be automatically restarted back to Windows where you can see that
your system partition is bigger now.

Creating Dual Boot Systems

For Windows computers

Release of Windows Vista has given a new impetus to the problem of establishing a dual boot system. In this connection
we decided to consider two the most frequently used situations a rank and file user may face, i.e. Windows Vista +
Windows XP and Windows XP + Windows Vista. Please note that for reasons of better security and system
independence these operating systems will be installed on different partitions. That is why we need to hide the first
system partition before installation of the second OS.

Windows Vista + Windows XP

Suppose you have got Windows Vista coming with your brand new computer. Everything is great except one thing —
your favourite applications simply reject to work correctly on it. Software updates are expected to release in the near
future, but you cannot wait any more. Thus the best way out is to leave Windows Vista intact and install the time-
proved Windows XP.

Most likely you have only one hard disk with only one partition (the only partition is always system). To install the
second operating system you need to repartition your drive first, as it requires a separate primary partition.

Install New OS Wizard

Q This scenario implies that operating systems will be installed on different partitions to
provide better security and system independence.

1. Click the Install New OS item of the Wizards menu.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

2. Onthe Wizard's Welcome page, click the Next button.
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3. Select the appropriate option to create a new primary partition on your hard disk.

Whers would you ke to install an operating system?

© | want 1o create a new pamary parition to install 05
A new parttion will be created by using unallocated space of your hard disk or unused space of existing
pattions. I is tha most prefarable way as no system or usar's data will be affactad dunng the installation
process

| want to use an existing pamary parttion to instal OS

In casa creation of 3 new pamacy pantition is not possbie here are airmady four pamary pattions on the
disi) or not desirable, you are free to salact any of exsting pamary pattions. Please note that all data on

the selected partition will be deleted £ you choose to format & later in this wizard. Besides make sure no
operating system has already been installed on that padition

4. On the next page of the wizard, define size of the new partition. If the selected hard disk contains blocks of free
space, the wizard will automatically merge them all and allocate the resulted space to create the partition. If

not, it will take 50% of the unused space of an adjacent partition, thus resizing it.

You can salect ether a block of unallocated spaca of the disk or an axsting padition, unusad space of which wi
be sarved 10 create 3 new panttion

Basic Hard Drsk 0 (VMware, VMware Virtual S SCSI Drsk Dev)

I @) Vista (C)) Il @) (Unallocated)
158.7 GB NTFS L_EAFLE:

[) MaxVolume Size: 3412GB

5. The next page enables to specify a file system and a number of additional parameters. Since we are going to
install Windows XP, the most preferable file systems are NTFS and FAT32. Click the Yes button to continue.

Partiion bype @‘-T"S 3
Aasign the following drive letter, | E :z]

Surmos test bevel: | Nore [

Q On this page you can specify a number of additional parameters that can also be of help.
However here we pay attention to the most relevant to fulfill our task.

6. Enter a label for the future partition in the textual field. It will later be used for the drive identification.

(05 labels will be displayed in the Boot Manager's startup menu to help you boaot the required operating
system.

05 label: |Windows ¥F|

7. The program will carry out all the necessary operations and then automatically restart the computer to initiate

the installation process.

Q If you’ve changed your mind on installing a new operating system, don’t insert its
distributive CD but press ESC when the following message appears:
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listributive CDADUD and pre any kew to continue

to abort the action

Make sure your BIODS iz zet up to boot from CD/DUD.

8. Install Windows XP on the newly created partition. We won’t go into details as for its installation, as you can find
all the necessary information in documentation that comes with the product. However to avoid any problems,
we consider it necessary to draw your attention on the following issues:

- You need a bootable distributive CD of Windows XP to install it;

- To automatically start your computer from this CD, make sure the on-board BIOS is set up to boot from CD first
or press F12 during startup to select a bootable device;

- Do not forget to select the newly created partition as destination.

Windows XP Profeszszional Setup
The following list shows the existing partitions and
unpartitioned = ce on this computer.
Use the UP and DOWN ARROW keys to select anm item in the list.
= To zet up Windows AF on the selected item, pr = EMNTER.
= To create a partition in the unpartitioned szpace

= To delete the selected partition. press D.

238591 HE Disk B at Id B on buz B on atapi [MBRI]

Partitionl {Inactive oot ManlB

9. Soif everything is OK, you’ve got to have by this moment Windows XP successfully installed. Your Windows
Vista however is still non-bootable. To fix this issue you need to launch the Boot Manager Setup wizard. To do
that, please install our program once again, but this time in Windows XP to activate Boot Manager.

.A To avoid double installation, please use our recovery media to activate Boot Manager.

10. Click Boot Management and then select Boot Manager in the Express Launcher.

11. Set up the Boot Manager wizard. The parameters offered by default will do in our case, so just complete the
wizard and it will automatically find the two operating systems and update the MBR.

Boot menu cptions

o Normal mode

Time to display the BootManager statup message

Choosa a hot key for stanup BootManager

12. Now restart the computer to make sure you have got a dual boot system.

Traditional way
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Q This scenario implies that operating systems will be installed on different partitions to
provide better security and system independence.

1. Click Switch to Full Scale Launcher in the Express Launcher.
2. Inthe main window select your hard disk on the Disk Map to make a block of free space on it.

Local Disk (E:)

" € Move/Resize Parition
g Resze or Move patition

Format Partition
@g Thia wizand tiekss you o foamet the seleciex! paiion

Basic Hard Disk 1 (VMware, VMware Virtual S SCSI Disk Dev)

Local Disk (E:)
4339 GB NTFS

3. Release some free space (not less than 10 GB to install Windows XP) from the partition. To do that, please call
the context menu for the selected partition (right click of the mouse button) and launch the Move/Resize dialog.

Disk View | Scheduled Tasks | Archives | Help

* Loci % Herd Disk Manager™ [ % [=aa
Are you sure you wank to move/resize volume (E:)?
*fou are about to move/fesize NTFS volume [No label], (E:). pA1E-7
Basic Hard Disk 1 (VMware, VMware Virtual 5 5CS51 Disk Dev)
42 Local Disk (E:)
455 9 GB NTFS
Volume siza: an E-ETI'JE :-B 101 ME - 511,997 MB
Fres space before: |0.97 ME :-B Obytms - 511,891.83 MB
@ Free space after- |0 Bytes [=] Obytes-511.82812 MB
ﬁ [T] Sectorto sector move
Salact this option to mowve partition amas that dont confain any data. This allows you to keap
the partiion's content after mave axactly as & was, but wil reguire more time, Disk
Basic Ha
Lo Yes o
459 Volume

4. Inthe opened dialog shift the edge of the partition to the left by the drag-and-drop technique. While doing this,
free space from the partition will be released (displayed in aqua-green). You can also do it manually by entering
the exact size of free space. Click the Yes button to continue.
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Are you sure you want to move/resize volume (E:)?
You ars about to move/resze NTFS volume [No label), (E:).

Basic Hard Disk 1 (VMware, VMware Virtual S SCS1 Disk Dev)
@) Local Disk (E:) ,_Irl @) (Unallocated)

W 262 3GB NTFS 2316GE
Volume size: 27¢.7%0513MB (¢ [=] 101 MB-511.933 MB
Free space before: (0,37 MB -:~E] Obytes - 511.831.43 MB

Free space after: | 237.201.32MB  12[»] Obytes -511.883.61 MB

[] Sectorto sector move

Selact this option to move padition areas that dont contain any data. This slows you to keep
the pattion’s content after move exactly as t was, but will require more tme

Q The Move/Resize dialog offers a number of additional parameters that can also be of help.
However here we pay attention to the most relevant to fulfill our task.

5. Now you have a block of free space sufficient in size to hold a new partition.

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)

Vista (C)) (Unallocated)
. 1527GBNTFS | 3412GB

6. Create a new partition to install Windows XP. To do that, please call the context menu for a newly created block
of free space (right click of the mouse button) and launch the Create Partition dialog.

Tools Changes Wizards Hard Disk Partition Archives View Help

® @, Hard Disk Manager™
Diek Are you sure you want to create a new partition on disk 0?

Un You are about to create 3 new patition n (Unallocated). 341.2 GB area. Please salect size,
postion and fle system of the new padiion

 Basic Hard Disk 0 (VMware, VMware Vitual S SCS| Disk Dev)

; ©) New Volume (F:) l
(L 201 260 s

Create new parttion as
Please specéy new partition size: 343451 5| 7MB - 345451 MB deve letter|

Please spacfy size of free space before the padition: 0 & OMB-349437 MB
Pleasa spacfy size of fres space afterthe pantticn: 0 & OMB-345443MB

Pleasa salact fle system for new pattion: | NTFS 3
Pleasa enter new volume labal New Volume
Please spechy drive letter: ool space

(¥) More options TV | ——

Basic H
l Vi 12GB
lsmes_'-_ e RTZGE .
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Define parameters of the future partition. By all means it has to be primary and since we are going to install
Windows XP, the most preferable file systems are NTFS and FAT32. Click the Yes button to continue.

Create new partion as [Z:')Z:_}J
Pleasa spechy new panttion size 249451 & 7MB-345451 MB
Please specfy size of free space before the paditicn: |0 * OMB-343437MB
Please specfy size of free space after the pattion 0 & OMB-345443 M8
Pleasa salact fils systam for new parttion: NTFS [+]

Pleasa anter new volume labal ey ma

Please spacfy drive latter F

¥) More options l Yes l L No J

Q The Create Partition dialog offers a number of additional parameters that can also be of
help. However here we pay attention to the most relevant to fulfill our task.

8. As aresult of the operation we have got a newly created FAT32 partition just enough in size to comfortably
work with Windows XP.
'Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)

I Vista (C:) New Volume (F:)
158.7 GB NTFS 341.2GB NTFS

Hide the Windows Vista partition to avoid writing any data on it during the Windows XP installation, as it is the
best way to provide system independence. To do that, please call the context menu for it (right click of the
mouse button) and launch the Hide Partition dialog. Click the Yes button to continue.

f rr—— ———
=R =

5

i Are you sure you want to hide the partition?

/ e
== You are zbout to hida partion (E:) [No label]. NTFS. Hiang tha pattion may

cause Orive letters (0 be changed
l Yes l No

.A Hiding of the system partition will make OS non-bootable, what is quite normal.

10. Apply all introduced changes. By default, our program works in the virtual mode of execution, so you have to

confirm all operations to let the program accomplish them. To do that, just click the Apply button on the Virtual
Operations Bar.

Fo
Apply pending changes 7

Do mot show this message again E Yeas E [ Mo
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11. The program will require the system restart to accomplish the operation in a special boot-up mode. Click the
appropriate button to agree.

After all the operations are completed you will not be able to restart the system, what is
2 quite normal. Nevertheless if you do try it, the following error will occur:

55 terminated unexpectedly with a sta

12. Install Windows XP on the newly created partition. We won’t go into details as for its installation, as you can find
all the necessary information in documentation that comes with the product. However to avoid any problems,
we consider it necessary to draw your attention on the following issues:

- You need a bootable distributive CD of Windows XP to install it;

- To automatically start your computer from this CD, make sure the on-board BIOS is set up to boot from CD first
or press F12 during startup to select a bootable device;

- Do not forget to select the newly created partition as destination.

Windows HP Profess Setup
The following izt shows I cing partitions and
W et vl 3
Use the UFP and fH ARROW Kk E o rot am item in the
Io et up Windows XP on the zelected item. press ENIER.
= To create a paprtition in the unpavtitioned space. press

= To delete the zelected partition. pwr

238591 HE Diszk B at Id B on buz B on atapi I[MBRI]

Partitionl {Inactive ¢ Boot HanlB B HE <
Paprtition i g MH :

.A Installation of Windows XP will make Windows Vista non-bootable.

13. Launch the Boot Manager Setup wizard. As your Windows Vista is non-bootable any more, you need to install
our program once again, but this time in Windows XP to activate Boot Manager.

.A To avoid double installation, please use our recovery media to activate Boot Manager.

14. Click Boot Management and then select Boot Manager in the Express Launcher.

15. Set up the Boot Manager wizard. The parameters offered by default will do in our case, so just complete the
wizard and it will automatically find the two operating systems and update the MBR.
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Boot menu cptions
o Normal mode
V| Timeowut for booting last usad configuration 15 saconds
Hidden mode
Time to display the BootManager statup message

Choosa & hot key for stanup BootManager

16. Now restart the computer to make sure you have got a dual boot system.

Windows XP + Windows Vista

If you've got Windows XP and are willing to try the latest Windows Vista but not sure your favorite applications will
flawlessly work on it, the best way out is to leave the time-proved Windows XP intact and install Windows Vista for

studying purposes.

As this very situation is very close to the previous one, please use the Windows Vista + Windows XP scenario. However
please take into consideration one more step you need to accomplish if you decide to use the traditional scenario:

1. Besides hiding of the system partition before installation of the second OS you need to make it inactive as well.
To do that, please call the context menu for it (right click of the mouse button) and launch the corresponding

dialog. Click the Yes button to continue;

File spstem | S
]
- Mok formalted &
y ' \ Are you sure pou want to zet the volume az inactive? ool 2
£ You aee sbout to set the volume [7) WinkP, NTFS as inactive. You computer may NTFS 1
na longer boat comacty.
[ g I | Mo
]
1848 GB HTFS
B H1Fs B FaT2 B FaTis Linies E w2 Lirass Ext3

Reviving the system partition

In case you are not able or not willing to complete the mentioned above scenarios, but have already reached the point
when all changes are applied and everything is ready to install the second OS, please do the following to make your
system bootable once again (only relevant for the traditional scenario):

1. Start up the computer from our Linux/DOS recovery media.

Recovery Media Builder can help you prepare our recovery environment either on a

f CD/DVD disc or a thumb drive.
To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Inthe Linux launch menu select Partition Manager.

3. Inthe main window select your non-bootable Windows partition on the Disk Map.
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- g = —

! Basic Disk 0 (VMware Virtual IDE Hard Drive) - 250 G

LI C: NTFS visia
K

[Basic Disk 0 |+ Model VMware Vinual IDE Hard Drive, Size 250 Gb
[N [Volume |Type |File System |Size |Used |Free |Volume label
Basic Disk 0 (Size 250 Gb)
= Frimary NTFS WGk L7Gh 199Gh  Vista
1 o Primary FAT32 497Gb  249Mb  496Gb  |Molabel]

4. Unhide the partition by calling the context menu for it (right click of the mouse button) and then selecting

Unhide.
I Create an image of partition_.. Al _ I
E Burn an image of pamiton o 0DV
| pe 250 Gb
E Restore partition from image... AlvR |Fr'et |'~|'I:-Iume |abel
izd
C fition... Al-C
aig Py paniien 199Gb  Vista
i \ 495 Gh [Ma label]
Creap Al
Format... Sl
Delete.., m
) ) Sat active
Wipe partition...
Clear free space
Convert ..
Setlabel
Resize/Move.. Habe
Umnaunit..
Change clusier size. ..
Madify Change moal §ize

Retest surface

5. Only for the Windows XP + Windows Vista scenario you need to make the system partition active as well by
calling the context menu for it (right click of the mouse button) and then selecting Set Active.

r Create an image of panition Ah-B _
Burr

n image of parion to COD/DVD

lard Drive, Size 400 Gb
Restore partition from image.. AR-R [Used |Free

Copy partition... AR-C

18Gh 1.2Gb
54 Mb 370Gk

a2 IS

-

Format.. e
Unhide

Delate.,

Wipe partition..

Clear free space
Convern
Set label...

ResizeMove...

Umaunt

Change cluster size..

6. You will be notified after the operations are completed.
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Operations list: Suboperation progress

1: Set panition flags

Operation progress

HEREENEEEE AR E AR

Time elapsed 00:00:26  Time to finish

Cwverall progress

Rebuilding panitions info...
All operations have been finished

7. Restart the computer.

System Migration Scenarios

Migrating system to a new HDD (up to 2.2TB in size)

Let’s assume that you’ve bought a new hard disk that is up to 2.2TB in capacity. It's faster and of much higher capacity
than your current system disk, so it’s quite natural you start thinking about system migration. We can help you do that.

If the target hard disk exceeds the 2.2TB capacity limit, please consult the Migrating system
to a 2.2TB+ HDD scenario.

To migrate your system to a hard disk that doesn’t exceed the 2.2TB capacity limit, please do the following:
1. Connect both source and destination disks to the computer.
2. Turn on the computer.

3. Click the Copy Disk item of the Wizards menu.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

4. On the Wizard's Welcome page, click the Next button.

5. On the Select Hard Disk to Copy page, select a source disk (a hard disk you want to copy).

On this page. you can choose a hard disk you would like to copy. All partitions from this hard disk will be copled
to the destination you will choose on the nexd page

Basic Hard Disk 0 (VMware. VMware Virtual S SCSI Disk Dev)

I @) Local Disk (C:)
435 5 GB NTFS

SR NTES

'MMG*I(VNW'E.VWRWMSSCSIG*NV)

I @) Local Disk (E 18asnc Hard Disk
" - 2 r 4

1 (VMware, VMware Virtual S SCSI Disk Dev)]"‘ E

F 1F

LASENIFDS LLS

14 GB FAT3Z

6. On the Select Target Hard Disk page, select a destination disk (a hard disk to copy contents of the source disk).
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Select a target hard disk. Al data from the source hard disk will be copied there. During copy operation, target
disk content will be deleted.

Basic Hard Disk 0 (VMware, VMware Virtual 5 SCS| Disk Dev)
@) Local Disk (C))
493 3 GE NTFS

.MMMEW.MWSESI[I*M]

'[.‘g Archives (G2) ' I ) Backup Capsule
Bl 5GENTFS 38GE

MMM&M.MWE%IE*M]

&) (Unallod Basic Hard Disk 3 (VMware, VMware Virtual S SCSI Disk Dev)|
499.9GE

A During the operation all contents of the destination disk will be deleted.

7. On the next page of the wizard, define the copy options. In our case we’d rather copy data with a proportional
resize to occupy the entire disk.

Choose copy options that sut best your task:
Copy options:
[~] HDD raw copy
| Parttions raw copy

Resize options:
|| Remove free blocks between parttions

Mark the checkbax to proportionally change the size of pantticns while keeping ther
relative order intact
Tip: This can be very convenient when migrating to a larger hard disk

8. On the Revise Copy Results page review all parameters of the operation.

Onignal hard dsk
Basic Hard Disk 1 (VMware, VMware Virual S SCS1 Disk Dev)
@) Local Disk (E) @ loca s ||[ @ .. I @) (Unallo.
34@? FF,T;{IV ZAGE NfFrsA ?4? %ZGE
Hafddskcopy,

Basic Hard Disk 3 (VMware, VMware Virtual S SCS1 Disk Dev)

@) locaDisk () || ] @ Local Di. ” @) (Unaloca .
173 GE FAT32 | M 1205GB NTFS 134 6GB

Proportional resize - the copy will take 500 GB (100 % of tarpet disk space)
Min Copy Size: 627.5MB | | | Max Copy Sze: s00GB

Select the range of the disk space that wil be occupied on the destination disk with copled ]

9. Complete the wizard and then apply the pending changes.
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=<

Apply pending changes 7

[ Do mot show this message again | Yeas 1[ Mo I

10. When copying is completed, shut down the computer.
11. Disconnect (physically) the source hard disk.

12. Boot the computer from the destination hard disk.

Hard Disk Optimization
To defragment an NTFS or FAT partition, please do the following:

A You must have administrator’s privileges to accomplish defragmentation of the system
partition.

1. Inthe main window, select a partition you want to defragment on the Disk Map.

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)

Vista (C:) New Volume (F:)
158.7 GB NTFS I 341.2GB NTFS
T ze: 158.7
Basic Hard Disk 1 (VMware, \{Uf:':sl'lj ]GSBS 7 GB e Disk Dev)
Local Disk (E) Free: 1473 GB jcated)
2683GBNTFS | [P

2. Launch the Defragment Partition dialog by calling the popup menu for the selected partition (right click of the
mouse button) and then selecting the menu item: Defragment Partition...

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dey)

Vista (C)) Y L
158.7GB NTFS D\ Analyze Fragmentation

-} Defragment Partition...
Basic Hard Disk 1 (VM S Dev)
! Defragment MFT...

Local Disk (E:)
C t MFT....
xa3ceNTEs | B Compc
Test Surface...
Poslc GFT Had Distca \‘r; Check File System Integrity LAt
—~ ad 3 s —— —
B NTFS B FAT Unux Bal

Properties...

<

3. Inthe opened dialog define settings of the operation. To improve the performance we recommend you to mark
the Do not save content of the Pagefile.sys or (and) Hiberfile.sys checkbox as these files are only needed for
the current Windows session.
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Defragment volume {(C:)7
ot Defragmantation may improve pedomancs of your system. For locked

violumas, owaver, this operation will requins e syedem reedam

erectores placement

Put draciones Leave 2 & ;I
Sort options

ort by size Dia roat st LI

Soet by modiication time: | Do not sort [=]

Q The Defragment Partition dialog offers a number of additional parameters that can also be
of help. However here we pay attention to the most relevant to fulfill our task.

4. Start the operation by clicking the Yes button.

Troubleshooter
Here you can find answers to the most frequently asked questions that might arise while using the program.
1. |trytorun an operation, but the program claims my partition is in use and suggests restarting the computer.

There are a number of operations that cannot be performed while your partition is in use (or locked in other
words). Please agree to reboot your machine to make the program accomplish the operation in a special boot-
up mode.

2. lrun an operation and restart the machine as required, but it just boots back into Windows without
accomplishing the operation.

Please run 'chkdsk /f' for the partition in question.
3. | cannot create a new partition on the disk.
There can be a number of reasons for that:
e The program cannot create a new partition on a dynamic disk.

e The program allows creating new partitions only within blocks of un-partitioned space. It cannot convert
a free space on an existing partition to a new partition.

4. |cannot copy a partition.
There can be a number of reasons for that:
- The source or target disk you select is a dynamic disk;
- 4 primary partitions (or three primary partitions and an extended one) already exist on the target disk.

5. Ineed to copy a partition. But when selecting a place where to make a copy, | always get a crossed circle sign no
matter which partition is selected.

The program enables to copy a partition only to a block of un-partitioned space. If you don’t have a block of free
space on your hard disk, please delete or reduce an existing partition to accomplish the operation.

6. |cannot do anything with my USB flash drive. | get a crossed circle sign when trying to select any area on it.
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Some USB flash drives don't have the MBR (Master Boot Record), that’s the cause of your problem. To fix the
issue please use the Update MBR function of our program or 'fixmbr' of the Windows installation disc to write a
standard code to your flash drive.

7. When trying to back up my system the program asks to restart the computer.
Most likely the Hot Processing mode is disabled. Please make it active in the program settings.

8. When backing up a partition with the VSS (Volume Shadow Copy Service) mode, the program throws "VSS could
not be started for processed volume".

Most likely you try to back up a FAT32 partition, which is not supported by VSS. Please use the Paragon Hot
Processing mode instead.

9. | cannot back up my hard disk to an external hard drive. Once started, the operation is aborted with the
following error: Hard Disk management, Error Code 0x1100a. What is wrong here?

The problem is that the Microsoft VSS service is set as the default Hot Processing mode in the program. But this
service has not been started in your WindowsXP/Windows2003/Vista. Please start this service (right click on My
Computer > Manage > Services > find Microsoft Volume Shadow Copy Service and make it active. Set also to
start it automatically).

10. When running a backup operation with the Paragon Hot Processing mode enabled, | get an error: error code
0x1200e "Internal error during Hot Backup"

Most likely your hard disk contains bad blocks. Please fix the issue with your HDD manufacturer's tool.
You can find a name of the tool you need here: http://kb.paragon-software.com

11. When running a backup operation with the Microsoft VSS mode enabled, | get the following error: error code
0x12016 "VSS: can't read volume data”

Most likely your hard disk contains bad blocks. Please fix the issue with your HDD manufacturer's tool.
You can find a name of the tool you need here: http://kb.paragon-software.com

12. When trying to back up to a network share, | get the following error: "i/o error" or "can't open/create file"
Please check whether you’ve got a permission to write to the selected destination or not.

13. When trying to restore a backup archive, | get the following error: "Can't restore to current selection" or
"Archive does not fit"

Most likely you’re trying to restore a backup of the whole hard disk to a partition or vice versa.
14. | set up a timetable for a task, but it fails to execute.
There can be a number of reasons for that:

- Windows Task Scheduler does not work properly. Check whether it is so or not by scheduling a simple task (call
Notepad through scheduling);

- You don’t have permission to write to the selected backup destination.

Glossary

Active Partition is a partition from which an x86-based computer starts up. The active partition must be a primary
partition on a basic disk. If you use Windows exclusively, the active partition can be the same as the system volume.

In the DOS partitioning scheme, only primary partitions can be active due to limitations of the standard bootstrap.
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The term backup originates from the time when the best way to protect valuable information was to store it in form of
archives on external media. It's become now a general notion to mean making duplications of data for protection
purposes.

Bootable Archive is created by adding a special bootable section when backing up the data to CD/DVDs. Thus you will
be able to restore the data from these archives without having to run the program, but by simply booting from these
CD/DVDs.

Cluster is the smallest amount of disk space that can be allocated to hold a file. All file systems used by Windows
organize hard disks based on clusters, which consist of one or more contiguous sectors. The smaller the cluster size, the
more efficiently a disk stores information. If no cluster size is specified during formatting, Windows picks defaults based
on the size of the volume. These defaults are selected to reduce the amount of space that is lost and the amount of
fragmentation on the volume. A cluster is also called an allocation unit.

Extended Partition is a partition type you create only on a basic MBR (Master Boot Record) disk. Extended partition is
used if you want to create more than four volumes on a disk, since it may contain multiple logical drives.

File System Metadata. The servicing structures of a file system, which contain information about allocating files and
directories, security information etc, are named the file system metadata. It is invisible for users and regular
applications because its accidental modification usually makes a partition unusable.

Hard Disk Geometry. Traditionally, the usable space of a hard disk is logically divided into cylinders, cylinders are
divided into tracks (or heads), and tracks are divided into sectors.

The triad of values {[Sectors-per-Track], [Tracks-per-Cylinder], [Amount-of-Cylinders]} is usually named the Hard Disk
Geometry or C/H/S geometry.

Tracks and cylinders are enumerated from "0", while sectors are enumerated from "1". These disk parameters play an
essential role in the DOS Partitioning scheme.

Modern hardware uses an advanced scheme for the linear addressing of sectors, which assumes that all on-disk sectors
are continuously enumerated from “0”. To allow backward compatibility with older standards, modern hard disks can
additionally emulate the C/H/S geometry.

Hidden Partition. The concept of a "hidden" partition was introduced in the IBM OS/2 Boot Manager. By default, an
operating system does not mount a hidden partition, thus preventing access to its contents.

A method of hiding a partition consists in changing the partition ID value saved in the Partition Table. This is achieved by
XOR-ing the partition ID with a 0x10 hexadecimal value.

Master File Table (MFT) is a relational database that consists of rows of file records and columns of file attributes. It
contains at least one entry for every file on an NTFS volume, including the MFT itself. MFT is similar to a FAT table in a
FAT file system.

MBR & 1st track of the hard disk is the Oth sector of the disk. MBR (Master Boot Record) contains important
information about the disk layout:

- The used partitioning scheme;

- The starting records of the Partition Table;

- The standard bootstrap code (or the initial code of boot managers, disk overlay software or boot viruses).
Generally, the Oth sector is used for similar purposes in all existing partitioning schemes.

The MBR capacity is not sufficient to contain sophisticated boot programs. That’s why the on-boot software is allowed
to use the entire Oth track of the disk. For example, boot managing utilities such as LILO, GRUB and Paragon Boot
Manager are located in the Oth track.
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Partition ID (or File system ID) is a file system identifier that is placed in the partition. It is used to quickly detect
partitions of supported types. A number of operating systems completely rely on it to distinguish supported partitions.

Partition ID is saved in appropriate entries of the Partition Table and takes only 1 byte of space.

Partition Label (or Volume Label) is a small textual field (up to 11 characters) that is located in the partition's boot
sector. This value is used for notification purposes only. It is detectable by any partitioning tool including the DOS FDISK
utility.

Modern operating systems save it within a file system, e.g. as a special hidden file. Thus it is able to contain a relatively
large amount of text in multiple languages.

Partitioning Scheme is a set of rules, constraints and format of the on-disk structures to keep information on partitions
located on a hard disk.

There are known several partitioning schemes. The most popular of them is the so-called DOS partitioning scheme. It
was introduced by IBM and Microsoft to use multiple partitions in the disk subsystems on IBM PC compatible
computers.

Another popular partitioning scheme is the so-called Logical Disks Model (LDM) that originates from the UNIX
mainframe systems. Veritas Executive accommodates a simplified version of LDM to the Windows 2000 operating
system.

Windows 2000 and XP support two quite different partitioning schemes: the old DOS partitioning scheme and the new
Dynamic Disk Management (DDM). The problem is that earlier versions of Windows do not support DDM. In addition,
most hard disk utilities do not support it as well.

Recovery Media is a CD/DVD disc, a USB flash card or even a floppy disk from which you can boot for maintenance or
recovery purposes.

Root Directory is the top-level directory of a formatted logical drive to include other files and directories. In modern file
systems (Ext2/Ext3, NTFS and even FAT32) it does not differ from other directories. This is not the case for old FAT12
and FAT16 file systems.

Serial Number. In the DOS partitioning scheme, every hard disk and every partition has a 32-bit serial number
represented by an 8-figure hexadecimal value. It is stored in the MBR and its value is assigned when the MBR sector is
initialized by Microsoft standard disk managing tools, such as Windows Disk Administrator and the FDISK utility.

In fact, a hard disk's serial number is not important for most operating systems and software. It is known that Windows
NT, 2000 and XP store its value in the database of assigned drive letters.

A partition's serial number is stored in its boot sector (in FAT16, FAT32 and NFTS file systems). Its value is assigned when
the partition is formatted. It does not play an important role for most operating systems and software as well.
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